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What's New

1 What's New

New features in ODBC Driver for Slack 1.3

¢ Improved compatibility with Node.js
e Improved compatibility with Tableau

e Improved compatibility with Vectorworks

New features in ODBC Driver for Slack 1.2

¢ Fixed connection timeout setting before opening connection

¢ Now tokens and passwords are stored in an encrypted form in the DSN record

New features in ODBC Driver for Slack 1.1

e Added support for SQL_ATTR_MAX_ROWS attribute
¢ Improved compatibility with Visual Basic in Visual Studio
¢ Improved compatibility with Linked Server in SQL Server

e Improved compatibility with Alteryx

New features in ODBC Driver for Slack 1.0

e |nitial release of ODBC Driver for Slack
e Windows 32-bit is supported
¢ Windows 64-bit is supported

2 General Information

1. Overview
2. Features

3. Compatibility

4. Requirements

5. Licensing
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2 ODBC Driver for Slack

6. Getting Support

2.1 Overview

Overview

Devart ODBC Driver for Slack is a high-performance connectivity solution with enterprise-
level features for accessing Slack from ODBC-compliant reporting, analytics, Bl, and ETL
tools on both 32-bit and 64-bit Windows. Our ODBC driver fully supports standard ODBC API
functions and data types and enables easy and secure access to live Slack data from

anywhere.

/ ODBC API M
+ ODBC Data Types T
T

Connection to Slack

Our data connector enables various ODBC-aware applications to connect to Slack directly
via HTTPS. If you have no direct access to Slack via HTTPS, you have the option of

establishing a connection through a proxy server.

Application
N |
HTTPS ap v
ODBC Interface "
Driver Manager Proxy
Slack

Devart ODBC Driver Cloud
for Slack
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2.2 Features

Connection to Slack

Application

HrTPS .. Our connectivity solution enables various
0DBC Interface .'
Driver Manager oy ODBC-aware applications to connect to
Slack . .
I T P Slack directly via HTTPS. If you have no

direct access to Slack, you have the option
of establishing a connection through a

proxy server.

Extended SQL Syntax

Our ODBC driver provides an unrivalled
opportunity to work with Slack objects just
as with SQL tables. The extended SQL

syntax allows you to use all the SQL

Select A _Name,

benefits in SQL-92 compatible SELECT e

From Agents A

. Where RoleID In (Select Id
statements: Srom Profiles

wWhere (Permissions_Contacts_View =
Or Permissions_Tickets_View =

* Complex JOINs  and Type = 'adnintstrator
« WHERE conditions e

® Subqueries

* GROUP statements

* Aggregation functions

* ORDER statements

® and more.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html
https://www.devart.com/odbc/slack/

4 ODBC Driver for Slack
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DML Operations Bulk Updates

Devart ODBC Driver for Slack provides Moreover, with our driver you can perform
support for DML (INSERT, UPDATE, bulk updates to Slack by combining SQL
DELETE) operations, which allows youto |statements into batches, thus simplifying
modify data in Slack in the same way as in |and speeding up large data modification
SQL databases. with Slack.

ODBC Conformance

The driver provides full support for common
ODBC interface:

e ODBC APIFunctions support g € \

= o
U

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to Slack from
various environments and platforms, that
support ODBC.
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Slack Compatibility

' Slack API ' °
" Our ODBC driver fully supports all data

types defined in the Slack API.
Moreover, the driver is compatible with the
Slack APl itself.

+/ Slack Data Types

Integration
Advanced Data Conversion

The driver is compatible with 3rd-party data

We have implemented advanced Data analysis tools, such as Microsoft Excel, and
Conversion mechanisms that provide bi- |integrates with various IDEs and systems
directional mapping between any Slack like Visual Studio, etc.

and ODBC data types. For a complete list of compatible tools and

platforms, see Compatibility.

Platforms Variety Fully Unicode Driver

. With our fully Unicode driver, you can
Devart ODBC Driver for Slack can be used

. ) ) o retrieve and work with any data from muilti-
with 32-bit and 64-bit applications on both
lingual Slack databases correctly, not

x32 and x64 platforms, so there is no need
. , depending on whether its charset is Latin,
to additionally configure the driver,
o ] Cyrillic, Hebrew, Chinese, etc., in any
applications or environment.
environment localization.

High Performance Support
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6 ODBC Driver for Slack

Every operation with Slack becomes o )

Visit our Support page to get instant help
significantly faster using such capabilities .

from knowledgeable and experienced
of our driver as Local data caching, _ _ _

professionals, a quick resolution of your
connection pooling, query optimization and . . .

problems, and nightly builds with hotfixes.
much more.

2.3 Compatibility

Slack Compatibility

Slack API v

Slack Data Types v

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)

e Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion
Embarcadero Delphi & C++Builder

FileMaker
Lazarus

Microsoft Visual FoxPro

CIS SIS 1SS

Microsoft Visual Studio
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General Information

Omnis Studio

PHP

PowerBASIC

CICL ]S

Python

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CICOIC SO K

SQL Server Reporting Services

Bl & Analytics Software

Alteryx

DBxtra

Dundas Bl

FICO Xpress Mosel

CIL[S ]S

IBM SPSS Statistics
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8 ODBC Driver for Slack

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

CICIC LSS (S

TIBCO Spotffire

Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

CIC S ]K

StarOffice

24 Requirements

The following requirements must be met for ODBC Driver for Slack:

¢ Only one version of ODBC Driver for Slack is installed on your system.

e NET Framework 4.5 or later is installed on your system.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

General Information 9

2.5 Licensing

ODBC Diriver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop
computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
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License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.
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No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written
permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.
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6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems
will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.
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This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.

26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Slack
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Slack:

¢ You can find out more about ODBC Driver for Slack installation or licensing by consulting

Installation and License articles of this manual respectively.

® You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for Slack developers through

the ODBC Driver for Slack Priority Support program.

Subscriptions

The ODBC Driver for Slack Subscription program is an annual maintenance and support

service for ODBC Driver for Slack users.

Users with a valid ODBC Driver for Slack Subscription get the following benefits:
¢ Product support through the ODBC Driver for Slack Priority Support program
¢ Access to new versions of ODBC Driver for Slack when they are released

¢ Access to all ODBC Driver for Slack updates and bug fixes

¢ Notifications about new product versions

Priority Support
ODBC Driver for Slack Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Slack-related questions from the ODBC

Driver for Slack developers themselves. Priority Support is carried out over email and has a
two business day response policy. Priority Support is available for users with an active ODBC
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Driver for Slack Subscription.

To get help through the ODBC Driver for Slack Priority Support program, please send an
email to support@devart.com describing the problem you are having. Make sure to include

the following information in your message:

Your ODBC Driver for Slack Registration number.
e Full ODBC Driver for Slack edition name and version number. You can find the version

number in DLL version information.
¢ Versions of the Slack server and client you are using.
¢ A detailed problem description.

e |f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Slack.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com.

3 Using ODBC Driver

1. Installation

2. Connecting to Slack

3. Connection String Parameters
4. Enabling ODBC Tracing
5. Supported ODBC API Functions

3.1 Installation

ODBC Driver for Slack currently supports Windows 32-bit and 64-bit.

¢ Regular Installation

¢ Silent Installation
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3.1.1  Windows

Installation on Windows

1. Download and run installer executive file.

2. Follow the instructions in the wizard.

ﬁ_,'-’:,! Setup - Devart ODBC Driver for Slack — X

devo rt Welcome to the Devart ODBC Driver for

Slack Setup Wizard

This will install Devart ODBC Driver for Slad: 1.0.0 on your
computer.

Itis recommended that vou dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

WARMIMG: This program is protected by copyright law and
international treaties,

ODBC Driver
for Slack

3. If you already have the specified installation folder on the PC or another driver version is
installed, you will get a warning. Click Yes to overwrite the old files with the current
installation, but it is recommended to completely uninstall the previous driver version first,
and then install the new one.

4. On the Select Components page, you can choose whether to install the 64-bit version of
the driver. Clear the checkbox if you do not need a 64-bit installation. There is also a

checkbox on this page that allows you to choose whether to install Help and Manual.
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16 ODBC Driver for Slack

ﬁ;@ Setup - Devart ODBC Driver for Slack —

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue,

Full installation w
ﬂ Devart QDBC Driver for Slack 19,9 MB
- (@ Driver for Win32 8,9 MB
.. [ Driver for Wing4 11,0 MB
B Help and Manual 2,4MB

Current selection reguires at least 24,3 MB of disk space.

< Back Cancel

5. On the License Information page, select when you want to activate the driver:
¢ Immediately after installation: Select Input Purchased or Trial activation key and
enter your key in the provided box, or click Load Activation Key and select the file
containing your key.

¢ Any other time: Select Activate product later.

You need to activate the driver even for the trial version.
You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.
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EEJ Setup - Devart ODBC Driver —

License Information

Enter yvour Purchased or Trial Key to activate the product. Getit on the
Customer Portal or load it from a file,

@ Input Purchased or Trial activation key

() Activate product later

U 1w FCODEMNGAEOF gbMzjuck JzV xGPY rkR Y SHB 7Tv

+th4+CRDPhEPZARMSEPY pPasaPTivaYeiQ 2bi TRigY yHAI FTTkhb dKEzWogdt oxsSUZ]
bzgVyAuSz2DgX FREMAhZ]D+HhPajyghTIEy Ez 7Due0QX tspppd SR IkS0uAILTIdOW
enAJQMzQGvDgF Sy /dz09B0Inrhg S9KEgficpgwTZIWE mmmTokvCkLICxSSom3Ei9gh
BqWcbDug/SlzakxSGEAWKSECSY 15gWYT +RIQF Y gALILIOtk 18N A=

Get Purchased or Trial Activation Key... Load Activation Key ...

6. Click Next to complete the installation.
7. Click Finish to exit Setup.

8. After the installation is completed, you need to configure the driver.

3.1.2 Silent Windows

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.
2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCSlack.exe /SILENT /ActivationKey=ylc7nmgdu2341laszxcvONGurjfhxm90LH

DevartODBCSlack.exe /VERYSILENT /ActivationkKey=ekhdh765mh09ukr237gfHRtrilwq9
Note: The installation is performed by entering a license key.

DevartODBCSlack.exe /SILENT /ActivationFile=d:\1lic.key
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3.2

3.21

DevartODBCSlack.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

Remote Installation

One of the key advantages of Group Policy is the ability to deploy software remotely using MSI
files. This section explains how to use Group Policy to remotely install the ODBC Driver for
Slack on client computers.

The information is organized into the following sections:
e Creating the MST File Using Orca

e Remote Deployment and Activation

e Upgrading Driver Version and License Key

Package Transformation

Creating the MST File Using Orca

To customize the installation of the ODBC Driver for Slack, you first need to edit the Windows
Installer Package (MSI) by creating an MST file. This will allow for customized installation of
an original Windows Installer (MSI) Package.

An MST file, or Windows Installer Setup Transform file, contains program configuration
settings. In our case, the MST file for the ODBC Driver for Slack will include the correct
license information. This MST file is used together with the original MSI package in the Group
Policy software distribution system.

There are many tools available for customizing MSl file settings, so you can choose the one
that best suits your needs. In this example, we'll be using Orca, which is available as part of
the Windows SDK Components for Windows Installer Developers. For more information
about Orca, visit the official Microsoft website.
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To start the process of MST file generation using the Orca editor, follow the steps below:

1. Launch the Orca application, then open the required MSl file by selecting Open in the File

menu or click the Open icon on the toolbar below.

€% Untitled - Orca — O X
File Edit Tables Transform Tools View Help
0O = e
Tables
&% Open X
Lookln:|, soft v| (I sl
~
I MName Date modified Type Size
ﬁlDevar‘tODBCSale;force 8/16/2024 410 PM  Windows Installer Package 80,5¢
Quick access
Desktop
m
Libraries
This PC
< >
i File name: | DevartODBC Salesforce ~ | | Open
Network
Files of type: Installer Database Files (*msi, “msm, *pcp, “msp) ~ Cancel
[ Open as read-only
Tables: 0 Mo table is selected. Mo column is selected.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for Slack.

2. As aresult, the Tables menu on the left side of the main application window will display the
properties of the selected MSl file.

3. Next, navigate Transform -> New Transform.
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&% DevartODBCSalesforce.msi - Orca

File Edit Tables
O =

Tables
AdminExecuteSeq
AdminUlSequence
AdvtExecuteSeque
AppSearch
Binary
CheckBox
Component
Condition
Control
ControlCondition
ControlEvent
CreateFolder
CustomAction

Transform  Tools  View

Mew Transform
Apply Transform...
View Patch...
Generate Transform...

Close Transform...

Transform Properties...

Help

4. To proceed, select Property from the Tables menu, then double-click any empty row on

the right side of the application window.

=4

File Edit Tables Transform Tools View Help

0 & =

Tables Property Value
AdminExecuteSequence UpgradeCode

AdminUlSequence
AdvtExecuteSequence
AppSearch

Binary

CheckBox
Cemponent
Cendition

Centrol
CentrolCondition
CentrolEvent
CreateFolder
CustomAction
Dialog

Directory
EventMapping
Feature
FeatureComponents
File

lcon
InstallExecuteSequence
InstallU|Sequence
LaunchCondition
ListBox

Media
MsiFileHash
Property
RadioButton
Reqlocator
Registry
RemoveFile
Shortcut

Signature
TextStyle

UlTest

Upgrade
_Validation

WIXUICUSTOMEXITDIALOGOPTIONALCHECKBOX

WixlJIRMOption
WIXULINSTALLDIR
IsTrial

ALLUSERS
Productiame
ARPPRODUCTICON
ARPHELPLINK
ARPURLINFOABOUT

{BE17A2F6-2B64-4ADF-A3EB-02DF 16208457}
1

WELCOME_TEXT
EXISTS
ISVALIDLICENSE
ARPNOMODIFY
MSIUSEREALADMINDETECT]
Manufacturer
ProductCode
ProductLanguage
ProductVersion
DefaultUlFont
WixUl_Mode

ErrorDialog

Infelcon

CRLF

TAB

SPACE
AdminProperties
SecureCustomProperties

(E Property ACTIVATIONKEY

Value

Column
Value - Localizable String[0], Required

'Q‘quanQiSkJOEWWSARIMBD/uquyﬂEvSTRCxFA4|

UseRM
INSTALLLOCATION
Trial
2
Devart ODBC Driver for Salesforce
App.ico
https://forums.devart.com/viewforum.php?f=33
httnef/ devart comfadhe/
Add Row > §C Driver for Salesforce 3.4.1 on your computer. Click Next to continue or Cancel to exit.
Name Value

Haz}

TEXT
'WERFOUND; OLDESTFOUND;SELFFOUND;WIX_UPGRADE_DETECTED

In the Add Row dialog that opens, make the following settings and press OK to apply the

changes:

e Property - enter ACTIVATIONKEY with capital letters only.

¢ Value - enter the valid OEM license key for the ODBC Driver for Slack.

As shown in the following screen, a new property, ACTIVATIONKEY, has been added, with
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the license key displayed in the value column next to it.

5. Once the configuration changes have been made, select Transform -> Generate

Transform.

&% DevartODBCSalesforce.msi (transformed by Untitled) - Orca

File Edit Tables Transform Tools View Help

O = E New Transform
Tables | ApplyTransform..
AdminExecuteSeq View Patch...

Value
{8E17A2FG-2B64-4ADF-AZEB-82DF1620B457}
1

AdminUlSequence "DIALOGOPTIONALCHECKBOX

AdvtExecuteSeque Ezrani i UseRM

AppSearch Close Transform INSTALLLOCATION

Binary Trial

CheckBox Transform Properties... 2

Component FrouUCHane Devart ODBC Driver for Salesforce
Condition ARPPRODUCTICON Appico

Control ARPHELPLINK https://forums.devart.com/viewforum.php?=53
ContrelCondition ARPURLINFOABOUT https://www.devart.com/odbc/
ContrelEvent WELCOME_TEXT

CreateFolder EXISTS

CustemAction ISVALIDLICENSE 0

Dizleg ARPNOMODIFY 1

Directory MSIUSEREALADMINDETECTION 1

EventMapping Manufacturer Devart

Feature ProductCode {AEF4136F-3503-4528-9FD4-8885780CC432}
FeatureComponents ProductLanquage 1033

File ProductVersion 341

lcon DefaultUIFont WixUl_Font_Narmal

InstallExecuteSequence Wixll_Made Mondao

InstallUlSequence ErrarDialog ErrorDlg

LaunchCenditicn Infolcon info

ListBox CRLF

Media TAB

MsiFileHash SPACE

Property AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIONALTEXT
RadioButton SecureCustomProperties

Reglocator ATIONKEY NGAEOFabMziuTLDiB5LOdOuEQaMa|
Reqistry

RemoveFile

Shortcut

Signature

The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on your computer, Click Mext to continue or Cancel to exit.
NO

ARPNOMODIFY; NETFRAMEWORK43; NEWERFOUND; OLDESTFOUND; SELFFOUND; WIX_UPGRADE_DETECTED
+1C/nd4kREUC

AMHKZP2ZX 54k TPLYidECH iU/ uV2KDSbhX3LxE6N

6. In the Save Transform As dialog that appears, enter a suitable name for the new MST file

and click Save to apply your settings.

=
File Edit Tables Transform Tools View Help
D& RO LA
Tables Property Value
AdminExecuteSequence UpgradeCode {8E17A2FG-2B64-4ADF-A3EB-22DF1620B457}
AdminUlSequence WIXUI_CUSTOMEXITDIALOGO 2 Save Transform As %
AdvtExecuteSequence ‘WixUIRMOption
AppSearch WIXUI_INSTALLDIR .
Binary I<Trial Savein: | soft v @& e mr
CheckBox ALLUSERS -
Component ProductName % Name Date modified  Type Si
Condition ARPPRODUCTICON Na items match your search.
Contral ARPHELPLINK Quick access
ContrelCondition ARPURLINFOABOUT
ControlEvent WELCOME_TEXT - puter. Click Next to continue or Cancel to exit.
CreateFolder EXISTS
CustemAction ISVALIDLICENSE Desktop
Dizleg ARPNOMODIFY
Directory MSIUSEREALADMINDETECTIO|
EventMapping Manufacturer n
Feature ProductCode Libraries
FeatureComponents PreductlLanquage )
File ProductVersion &
lcon DefaultUIFont =
InstallExecuteSequence Wixll_Mode This PC
InstallUlSequence ErrarDialog
LaunchCondition Infalcon S
ListBox CRLF L < >
Media TAB Network
MsiFileHash SPACE Fie name [Dsvat0DECSalestoree | Save
Property AdminProperties
RadioButton SecureCustomProperties Save as type: Windows Installer Transform (" mst) ~ Cancel
Reglocator
Registry

RemanveFile
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7. If successful, the encryption message DevartODBC Salesforce.msi (transformed by
DevartODBCSalesforce.mst) - Orca will be displayed at the top of the Orca application
window.

ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce.mst) - Orca — [} s
File Edit Tables Transform Tools View Help

b= A - 2|

Tables ~ | Property Value
AdminExecuteSequence WixUIRMOption UszeRM
AdminUlSequence WIXULINSTALLDIR INSTALLLOCATION
AdvtExecuteSequence I=Trial Trial
AppSearch ALLUSERS 2
Binary ProductMName Devart ODBC Driver for Salesforce
CheckBox ARPPRODUCTICON App.ico
Component ARPHELPLIMEK https://forums.devart.com/viewforum.phpif=53
Condition ARPURLINFOABOUT https://www.devart.com/odbc/
Control WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.4.1 on you
ControlCondition EXISTS MO
ControlEvent ISVALIDLICENSE 0
CreateFolder ARPMNOMODIFY 1
CustomAction MSIUSEREALADMINDETECTION 1
Dialog Manufacturer Devart
Directory ProductCode {AEF4136F-3503-4528-9FD4-2885780CC432}
EventMapping Productlanguage 1033
Feature ProductVersion 341
FeatureComponents DefaultUIFont WixUl_Font_Mormal
File Wixl_Mode Mondo
lcon ErrorDialog ErrorDlg
InstallExecuteSequence Infolcon info
InstallUlSequence CRLF
LaunchCondition TAE
ListBox SPACE
Media AdminProperties WIXUILCUSTOMEXITDIALOGOPTIOMNALTEXT
MsiFileHash SecureCustormProperties ARPNOMODIFY: NETFRAMEWORKAS;NEWERFOUMND; OLDESTFOUMD; SELFF
Property | ACTIVATIONKEY ulw7iCODENGAEOFabMziuflXuByv3wbzR2Et1 CEDMCTIh+ TWwieLHrTrc1RLF
RadicButton
Realocator bl B

Tables: 37 Property - 29 rows Mo celumn is selected.

In case of a positive outcome, the newly created MST file will be located in the folder you
specified, alongside the MSl file.

3.2.2 Deployment and Activation

Installing and Activating Software Remotely

Group Policy automated-program installation is specifically designed for deploying Windows
Installer packages (MSl files). Therefore, when deploying the ODBC Driver for Slack using
Group Policy, be sure to use the corresponding MSl file for the ODBC Driver for Slack.

Prerequisites: Locating the MSI Installation File

Prior to making configuration settings in the Group Policy, you'll need to create a distribution
folder:

1. Create a shared network folder on the publishing server.
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2. Set the appropriate sharing permissions on this folder to allow read access to the driver

installation package for all domain users.

3. Download the ODBC Driver for Slack MSl file, and place it in the network folder.

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Driver for Slack.

Further in this section, you'll find more detailed information on how to deploy and activate the
ODBC Driver for Slack on remote client computers using Group Policy.

Server-Side Actions
1. Open the Group Policy Management desktop application.

2. In the Group Policy Management window, navigate to the desired forest node, then
expand the appropriate option under the Domains node. For this example, we'll select
devart-test.test. Right-click the Domains node, and from the context menu, select Create

a GPO in this domain, and Link it here.
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ZL Group Policy Management

3 File Action

View Window Help -

L Al NERIEREI 7 o

5L Group Policy Management

v _i\‘ Forest: devart-test.test
v (55 Domains
w 3 devart-test.test
s Default Dol
sz Devart ODE
o Windows L
2| Domain Co
= Group Poli
# WM Filters
Ll Starter GPC
i@ Sites
st8 Group Policy Mod
4 Group Policy Resu

Create a GPO in this domain a

devart-test.test
Status  Linked Group Policy Objects  Group Policy Inheritance  Delegation
Create a GPO in this domain, and Link it here...
Link an Existing GPO...

Block Inheritance

*ve Directory and 5YSVOL replication for this domain as it relates to Group Policy.

Group Policy Modeling Wizard... 3t test is the baseline domain controller for this domain. Change

MNew Organizational Unit

Search in exists for this domain.

Change Domain Controller... w to gather infrastructure status from all of the domain cortrollers in this domain.
Remove

Active Directory Users and Computers...

View >

Mew Window from Here

Refresh
Help

3. You can now create a New Group Policy Object. In the New GPO dialog enter a name for

the new object and click OK. The new GPO will then appear within the Group Policy

Management container.

For example, let's create a GPO named after the ODBC driver name.

Mew GPO >
Mame:
|Deuart ODBC Driver|
Source Starter GPO:
{none) »

Cancel

Keep in mind that each ODBC Driver for Slack Windows installation package corresponds to

one Group Policy Object (GPO), which is important for managing future software upgrades.

To install multiple drivers using Group Policy, you need to create a separate GPO for each

driver you want to deploy.
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4. Right-click the new object and select Edit from the context menu.

= Group Policy Management —
5L File Action View Window Help

&= HEIXc HE

5L Group Policy Management Devart ODBC Driver
v _ﬁ Forest: devart-test.test

- i Scope  Details Settings Delegation
v |55 Domains

w 3 devart-test.test Links
s Default Domain Policy Display finks in this location: devart test test
s Devart ODBC Driver The follnwing sites damainsand Ol s are linked to this GPO:
5| Windows Update Server Edit... h — P o
== : orce inl able Eil
2 | Domain Controllers .
v [ 5} Group Policy Objects ) [FrEs No Yes devart-test test
=[ Default Domain Centrollers Pe N Enakie
=[ Default Domain Policy Save Report...
= Devart ODBC Driver View .
=] Windows Update Server )
% WM Filters Mew Window from Here oy to the following groups, users, and computers:
a Starter GPOs Delete
i Sites Rename
565 Group Policy Modelin
il p Y g
4 Group Policy Results Refresh
Help we Properties
WMI Filtering

This GPO is linked to the following WMI fiter:

Open the GPO editor

5. In the left pane of the Group Policy Management Editor, navigate to Computer
Configuration --> Policies --> Software Settings --> Software installation. Your
current deployment package will appear in the right pane. Right-click Software

installation, then select New --> Package.
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1L Group Policy Management -
i FI|E . A8 A Llal
E[ Group Policy Management Editor — O *
|
——— File Action View Help
15 Grou
vAarRe=® 2@ E 6= HE
¥ '5| 5 Devart ODBC Driver Name Version Deployment st.. Source
™ v i Computer Configuration
w || Policies
~ [ Software Settings
Software installation
» [ Windows Settings MNew > Package... b
> [ | Administrative Templat )
= View ¥
» || Preferences
v i, User Configuration Paste
< L
> 4 » || Policies Refresh
s > [ ] Preferences
[ Export List...
Properties
Hel
< =l
IL
Adds a package.
WMI Filtering

This GPO is linked to the following WMI filter:

6. In the Group Policy Management Editor dialog that opens, select the desired MSI

installation file and click Open.

& Group Policy Management —

s File fmtimm  lfim  Ufiecles Llale

| & Group Policy Management Editor - o X
== N
/1| =
|5 Grou [ Open x
e -ﬁ;_ T « test-ad-del » soft v 0 Search soft el
A
o - ==
Organize « Mew folder B== ~ [ o oft\DevartODBC
[&] Pictures ~ Name Date modified Type
B Videos 15! DevartoDBC 8/19/20245:50 PM  Windows Installer Pack
‘am Local Disk (C:)
|_ﬂ Metwork
_ﬁ L 4 >
i File name: |De\.rartODBC v| Windows Installer packages (*.r
< >

WMI Filtering
This GPO is linked to the following WM fitter:
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7. In the Deploy Software dialog, select Advanced to specify the software deployment

method. The Advanced deployment method allows you to make necessary modifications

to the MSl file, such as creating the MST file in Orca.

Deploy Software

Select deployment method:

Published

Select this option to configure the Published or Assigned options,
and to apply modffications to a package.

Cancel

8. In the Properties dialog of the installation package that opens, go to the Modifications tab

and select Add. Browse for the corresponding MST file, select it, and click Open to apply

the settings.

\&l Group Policy Management
2 File Action View Window Help
e @ X G|

54 Group Policy Management pevart QUBL HnverFroperties

|
Fi t: devart-test.test P
e i ?res SvartesLies General Deployment Upgrades Categores Modfications  Security
~ |55 Domains
w 335 devart-test.test Modffications or transforme allow you to customize the package and are
4 Default Domain Policy applied to the package in the order shown in the following list - O
sz Devart ODBC Driver
EEJ.’ Windows Update Server Move Up
= | Domain Controllers
= Group Policy Objects Move Down ion  Denlovment st. Source
& WMI Filters *
] Starter GPOs
& Sites P L « test-ad-decl » soft v O Search soft -l
s Group Policy Modeling
2 Group Policy Results Organize »  Mew folder - W @
&=/ Pictures L MName Date modified  Type
Removel [ Videos [ DevartODBC.mst 8/16/202440... MST File
s Local Disk (C)
Important! Do not press OK uf
comectly. For more informatiol
then dlick What's this? = Network
v £ >
(RN B0 evart ODBC . mist] v| Windows Installer transform pa
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9. If configured correctly, the Group Policy Management Editor window should look as

follows:

'=[ Group Policy Management Editor
File Action View Help
e HEEC= HE
- - =~
(5[ Devart ODBC Driver * || Mame Version Deploymen... Source
v (i Computer Configuration
w || Policies
~ [ | Software Settings
Software instal
| Windows Settings
| Administrative Ter
| Preferences

Devart ODBC Driver 3.4 Assigned Wtest-ad-dcT\soft\DevartODBC.msi

w 4 User Configuration w
< >
Client-Side Actions

For the ODBC Driver for Slack to be successfully installed on remote client machines, all
domain users must restart their computers after logging in for the first time.

In case of successful deployment, the ODBC driver will be installed on the client's computer.

To verify, open the ODBC Data Source Administrator on the client's machine and add the
deployed ODBC driver.
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Create Mew Data Source

>
Select a driver for which you want to set up a data source.
MName Version Col
Devart ODBC Driver 3.04.01.00 De
SGL Server 10.00.15041.01 M

< Back Cancel

All information on the deployed driver is accessible upon clicking the About tab.
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Devart ODEC Driver Cenfiguration X

General Advanced Settings Security Settings  Tracng License About

Devart ODBC Driver
Desktop License

Version:

devart

5.3.0
Web:

www, devart, comfodbc

E-mail:

support@devart.com

ODBC Driver

© 2015-2025 Devart. All right reserved,

Test Connection . Cancel

Similarly, the valid license key will be automatically activated after the successful installation
of the ODBC Driver for Slack.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

See Also
e Creating the MST File Using Orca

¢ Activating on Windows - ODBC Driver for Slack

e License Information - ODBC Driver for Slack

3.23 Software Upgrade

Automatic Software Update Using Group Policy

If the ODBC Driver for Slack was initially deployed through Group Policy, it can be easily
updated to a newer version. Follow the steps below to update both the ODBC Driver for Slack
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and the license to newer versions on all remote computers in the domain.

1. Download the ODBC Driver for Slack installation MSI file of a newer version and place it in

the shared network folder.

2. Create a new MST file with a new license key using Orca.

If your license is still valid, there's no need to create a new MST file. Use the current MST file

instead.
ﬂ DevartODBCSalesforce.msi (transformed by DevartODBCSalesforce_new_key.mst) - Orca — [m] *
Eile Edit Tables Transform Tools View Help
= #
Tables ~ | Property WYalue
AppSearch UpgradeCode {8E17A2F6-2B64-4ADF- ASEB-82DF 16208457}
Binary WIXUI_CUSTOMEXITDIALOGOPTIOMALCHECKBOX 1
CheckBox WixUIRMOption UseRM
Component WIXUI_INSTALLDIR INSTALLLOCATION
Cendition IsTrial Trial
Control ALLUSERS 2
ControlCondition ProductMame Devart ODBC Driver for Salesforce
ControlEvent ARPPRODUCTICON App.ico
CreateFolder ARPHELPLINK https://forums.devart.com/viewforum.php?f=33
CustomAction ARPURLINFOABOUT https://www.devart.com/odbc/
Dialeg WELCOME_TEXT The Setup Wizard will install Devart ODBC Driver for Salesforce 3.3.0 on your computer, Click Next to continue
Directory EXISTS MO
EventMapping ISVALIDLICEMSE ]
Feature ARPNOMODIFY 1
FeatureComponents MSIUSEREALADMIMDETECTION 1
File Manufacturer Devart
lcon ProductCode {73ABASBS-E56E-4828-BE3B-B6FDABSECS39)
InstallExecuteSequence ProductLanguage 1033
InstallUlSequence ProductVersion 3.5.0
LaunchCondition DefaultUIFont Wixl|_Font_Normal
ListBox WixUl_Mode Mondo
Media ErrorDialog ErrorDig
MsiFileHash Infolcon info
| Property CRLF
RadicButton TAB
Reglocator SPACE
Reqistry AdminProperties WIXUI_CUSTOMEXITDIALOGOPTIOMALTEXT
RemoveFile SecureCustomProperties ARPMOMODIFY:NETFRAMEWORK45;NEWERFOUMD; OLDESTFOUND; SELFFOUND;WIX_UPGRADE_DETECTED
Shortcut ACTIVATIONKEY wiCODBNGAEOFabNziuflXu RIEt1CADMCTIh+TVw/el HrTrc1RLFrwmdCSawbSwaRMXara3 kDofi2d
Signature
TextStyle
UlText
Upgrade
_Validation v | < >
Tahles: 37 Pronerty - 79 rows. Mo column is selected

The MSI file for the ODBC Driver for Salesforce is taken as an example to illustrate the Group
Policy installation process. Use the same steps described in this section when installing the
ODBC Diriver for Slack.

3. Follow the same workflow as outlined in Step 4 to Step 7 of the ODBC Driver for Slack

Remote Deployment and Activation section.

4. In the Properties dialog that appears after selecting the Advanced deployment method,

go to the Upgrades tab and click Add.
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I . — O X
2) Properties ? X
F
H General Deployment Upgrades Categories Modffications  Security
il
fi Packages that this package will upgrade: Add Upgrade Package 4
1 Choose a package from BCSalesforce...
(®) Cumrent Group Policy Object (GPO)
() A specific GPO:

Browse...

Package to upgrade

Devart ODBC Driver for Salesforce (2)

Add... Remove

Required upgrade for existing packages

Packages in the cument GPO that will upgrade this package:

() Uninstall the existing package, then install the upgrade package
(®) Package can upgrade over the existing package

ok Conce

Make sure to select the following check boxes while adding the package:

e Current Group Policy Object
e Package can upgrade over the existing package

5. Browse for the corresponding GPO object and click OK to apply the settings.
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Browse for a Group Policy Object

Domains/OUs  Sites Al

< |
|_'::>
g
[
1

Look in: |5 devart test test

All Group Paolicy Objects stored in this domain:

Mame

|=[ Defautt Domain Controllers Policy
\=[ Defautt Domain Policy

E Devart ODBC Driver for Salesforce
=] Windows Update Server

6. Now the Upgrades tab of the Properties dialog will list a new package with a newer

version.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modffications  Security

Packages that this package will upgrade:

Upgrade Devart ODBC Driver for Salesforce

Upgrade Devart QDBC Driver for Salesforce (2]

Add... Bemove

Required upgrade for existing packages

Packages in the cumert GPO that will upgrade this package:

Corcs

35

7. Go to the Modifications tab in the same properties dialog, click Add and browse to the

MST file.

We have already created a new MST file with a new license key in Step 2.
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Devart ODBC Driver for Salesforce (2) Properties ? >

General Deployment Upgrades Categores  Modifications  Security

Maodffications or transforms allow you to customize the package and are
applied to the package in the order shown in the following list:

Modffications:

West-ad-de 1soft \DevatQDBC Salesforce_new keym Mave Up

Move Down

oo

Impaortart! Do not press OK until all transforms are added and ordered
comectly. For mare information, right-click on the Modfications list box, and
then click What's this?

Corcs

8. In case of a positive outcome both the old and new versions of the driver package will be

displayed in the Group Policy Management Editor.

= Group Policy Management Editor
File Action View Help

as Hm EQ HE

- Devart ODBC Driver for Salesfor|| Name Version Deploymentst.  Source
v i Computer Configuration Devart ODBC Driver for Salesforce 34 Assigned \\test-ad-dc\soft\DevartODBCSal...
v [ Polides Devart ODBC Driver for Salesforce (2) 35 Assigned \\test-ad-dc1\soft\DevartODBCSal..

v [ Software Settings
Software installat

| Windows Settings
| Administrative Templ

| Preferences

- n".; User Configuration
_ Policies
_ Preferences

Once the GPO configuration on the server is complete, the ODBC Driver for Slack will
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automatically update to the latest version each time a client computer restarts.

Client-Side Actions

To update the ODBC Driver for Slack to a newer version on remote client machines, all
domain users must restart their computers after their first login.

If successful, both the driver and the license key will be automatically updated to the new
version on remote computers. For detailed instructions on how to view the technical details of
the ODBC Driver for Slack after upgrading, refer to Client-Side Actions.

See Also
e Creating the MST File Using Orca

¢ Remote Deployment and Activation - ODBC Driver for Microsoft Access

e Activating on Windows - ODBC Driver for Slack

¢ License Information - ODBC Driver for Slack

3.3 Product Activation

See how to activate Devart ODBC Driver for Slack:

e Obtaining Activation Key

e Activation on Windows

e Where to see the license information

3.3.1  Obtaining Activation Key

Follow these steps to obtain your product activation key:

¢ From the Customer Portal:

1. Open the Customer Portal and sign in.

2. On the Product licenses page, select the driver.

3. Click Copy to clipboard to copy the activation key.
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Product licenses
g ODBC Driver Export license details
LicenselD Owner Assigned Type
> 375E-422F-001 email@example.com NOT ASSIGNED Single

Activation key:

nkLId7irC4nhZdUFN/6gbWxHYJhCHIyILz/195Nu90z Tp5cTIff 2pFg+LImLxlyGXPThgvA+D4jRhwwWBYXBEVZn
azsgkJiZwohsuG3+/Biy/MMHUNZhtrpM8lc3119Y wocKuaB4ANeGE7IC78ddalFfPumci+D280t829+16tnCSPwqV7
B8Q3GS1ZIoWYwWFIiJIiQvaN1cSYnep6553/3InHiF CaaKdfE46WdbqgQrimLNfHU+ZwvFDR3bTFKcEvgGgHITTCh
VAWDR4A4AXOIgBa==

Copy to clipboard

Assign this license to:

¢ From the registration email:
1. Locate the registration email you received from Devart after installing the driver. This
email contains a Purchased or Trial activation key.

2. Copy the activation key.

See also:

e Activation on Windows

3.3.2 Activation on Windows

Driver Activation After Installation

To activate your installed driver, perform the following steps.
You need to activate the driver even for the trial version.
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.
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'-3. QODBC Data Source Administrator (84-bit) =4

lUser DSM System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Flatform  Driver 2 Add...
QDBC Driver for Azure_x32 32-bit Devart ODBC Driver for SQL 5

QDBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynam

ODBC Driver for Firebird_x32 A2-bit Devart QDBC Driver for Firebirc Configure...

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Gd-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDE_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQ1 ¥
£ >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Inthe Create New Data Source dialog, select the installed driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialog, navigate to the License tab, and click Input Activation Key.
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Devart ODBC Driver for Slack Configuration
General Advanced Settings License  About

License Information:

Trial period:
29 days left

Input Activation Key...

Test Connection 0K Cancel

5. Here, you can activate the driver using one of the following methods:

¢ Enter an activation key: Paste your activation key into the corresponding box.
e Load an activation file: Click Load Key and select the file that contains the activation

key.

You can find your activation key in the registration email or your Customer Portal account.

To open the Customer Portal, click Get Purchased or Trial Activation Key.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

42 ODBC Driver for Slack

Devart ODBC Driver Configuration x
General Advanced Settings Security Settings  Tracing License  About

License Information

Mot registered

You may register ODBC Driver at
https: ffwww.devart, comfodbc/<driver=fordering. html

-

Input Activation Key >

Activation Key

U 1w FCODENGAEDFgbMzjuck IzVxGPY kR Y IHE TTv

+th4-+CROPh&PZARMS3pY pPasaPTivaeiQ 2bi 7Fig Y yHAI FITkhb /dkazwWog 4t oxSUZibzgVyAuSz 2DgX FREM
AJjhZj0+hPlajyghTIEy Ez TDxe0Q X tspppd SR Ik30uAIb fIdOWenAIQMNzQGivDgFSx fdz09B 0 Inrhg 59KEg fic
powTZIWa mmmTokyCkLICx5SomSEi9ghS8gWchDug/Slz8 kxS G AWKSGCHY 15gWYr
+/RZOF{¥gALILIOt 13NA |

Load Key... Cancel

Get Purchased or Trial Activation Key...

Input Activation Key... .

eactivate Product

Test Connection - (8.4 Cancel

6. Click OK.

3.3.3 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. Open the ODBC Data Source Administrator.

2. On the System DSN tab, click Add.
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'-3. QODBC Data Source Administrator (84-bit) =4

lUser DSM System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Flatform  Driver 2 Add...
QDBC Driver for Azure_x32 32-bit Devart ODBC Driver for SQL 5

QDBC Driver for BigCommerce_x32 32-bit Devart ODBC Driver for BigCor Remove
QDBC Driver for Dynamics_32 32bit Devart ODBC Driver for Dynam

ODBC Driver for Firebird_x32 A2-bit Devart QDBC Driver for Firebirc Configure...

QDBC Driver for Magento_x32 32bit Devart ODBC Driver for Mager
QDBC Driver for MailChimp_x32 32bit Devart ODBC Driver for MailCh
QDBC Driver for Mongo DB Gd-bit Devart ODBC Driver for Monge
QDBC Driver for MongoDE_x32 32bit Devart ODBC Driver for Monge

QDBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySQ1 ¥
£ >

An QDBC System data source stores information abowt how to connect to the indicated data provider.
1| A System data source is visible to all users of this computer, including NT services.

Cancel Apply Help

3. Select the driver, then click Finish.
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Create Mew Data Source >

Select a driver for which you want to set up a data source.

MName 1A

Devart QDBC Driver for BigCommerce
Devart QDBC Driver for Dynamics CRM
Devart ODBC Driver for Firebird

Devart ODBC Driver for FreshBooks
Devart QDBC Driver for Google BigGuerny
Devart ODBC Driver for InterBase

Devart ODBC Driver for Magento

~ LTl o r B e

< >

< Back Cancel

4. In the configuration dialogue, navigate to the License tab to view the license details.
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Devart ODEC Driver Cenfiguration X
General Advanced Settings  Security Settings  Tradng License  About

License Information

Company:
Devart

User name:
QDBC Account

License number;
299E-2C8-001

Licensed for:
1 Desktop

Subscription for free updates expires on 12/31/2029

Get Purchased or Trial Activation Key...
Input Activation Key...

Deactivate Product

Test Connection . Ok Cancel

3.4 Connecting to Slack

Windows DSN Configuration
After installing the driver, create a DSN for Slack in the ODBC Data Source Administrator.
1. Open the ODBC Data Source Administrator.
e Type oDBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open

ODBC Data Sources from Control Panel > Administrative Tools. Note that before
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Windows 8, the icon was named Data Sources (ODBC).
e Alternatively, you can run c:\Windows\SysWOW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.
2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.
. Click Add. The Create New Data Source dialog will appear.
. Select Devart ODBC Driver for Slack and click Finish. The driver setup dialog will open.
. Enter the connection information in the appropriate fields.

. You may test the connectivity by clicking Test Connection.

~N O o b~ W

. Click OK to save the DSN.

Devart ODBC Driver for Slack Configuration X

Data Source Mame  Slack

Description Devart ODBC Driver for Sladk

Access Token SRR BRRRRRRERORRRRRRI HSEVETDkEn
Sign in to Slack

Proxy Server Part i)

Proxy User ID

Proxy Password [ save Password

Test Connection s Cancel

See Also

Connection Options
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3.5 Connection String Parameters

Slack ODBC Connection String Parameters

The following table lists the connection 3arameteri options for Slack.

Param _—r
aramet Description
er
Access The access token allows authorization of a specific application to access
Token Slack data.
Proxy Settings
Proxy
The proxy hostname or IP address.
Server
Proxy User
D The proxy server account ID.
Proxy
The proxy password.
Password

Proxy Port | The port number used to connect to a proxy server.

Advanced Settings

Allow NULL
i To retrieve metadata, not all parameters according to MSDN can accept a

strings

9 null value. Iif NULL, the driver should return an error. But some 3rd-party
Em

Py tools pass NULL to the parameters. These options should be enabled for
strings as ot

compatibility with such tools.

NULL

Connection The time (in seconds) to wait for a connection to open before terminating

Timeout an attempt. The default value is 60.

OoDBC Used to set the behavior corresponding to the ODBC specification
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Behavior

RegionalNu

mberSetting

S

RegionalDat

eTimeSettin

gs

ReturnForei

gnKeys

version that a third-party tool expects. The behavior of ODBC driver can
be changed by setting a value for the SQL_ATTR_ODBC_VERSION
attribute by calling the SQLSetEnvAttr function. But some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the specified version or pass an incorrect value there.
In this case, the required behavior can be explicitly specified in the
Connection String by setting the ODBC Behavior parameter. The possible

values are:

* Default - default ODBC behavior determined by a third-party tool.
* Ver 2.x- ODBC 2.x behavior is explicitly set.

* Ver 3.x- ODBC 3.x behavior is explicitly set.

Enables the use of local regional settings when converting numbers to

strings.

Enables the use of local regional settings when converting dates and

times to strings.

Use the option to specify whether the driver must return foreign keys.
Retrieving metadata about foreign key constraints is a time-consuming
operation; many third-party tools request foreign key metadata even whey
they do not actually need this information. Note that enabling the option
may degrade performance of data access operations. The default value is

False.

Sets the string value types returned by the driver as Default, Ansi or

Unicode.

String Types|® Default - the driver defines the string types.

® Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR
and SQL_LONGVARCHAR.
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® Unicode - all string types will be returned as SQL_WCHAR,
SQL_WVARCHAR and SQL_WLONGVARCHAR.

The parameter value should be changed if any third-party tool supports
only Ansi string types or Unicode ones.

QueryTimeo The time to wait for a query execution result before terminating and
ut generating an error.
Specifies whether all the datetime values retrieved from the data source
are returned as UTC values or converted to local time and whether the
UTC Dates
date values specified on the application side (e.g., in SQL statements) are

considered UTC or local. The default value is false.

Slack Connection String sample

DRIVER={Devart ODBC Driver for Slack};Access Token=myaccesstoken

3.6 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-Wide tracing for all user identities. For

example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps

below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed
bitness.

2. Select the Tracing tab.

3. If necessary, change the default Log File path. Make sure that the path is writable by the
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application, then click app1ly.
4. Click start Tracing Now.
5. Restart all application processes.
6. Click Test connection in the DSN settings to make sure the driver is able to connect.
7. Reproduce the issue.
8. Click stop Tracing Now on the Tracing tab.

9. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.
3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:

[ODBC]
Trace=Yes
TraceFile=/home/test/devart. log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

3.7 Usage Statistics

Usage Statistics

ODBC Driver for Slack can collect anonymous usage statistics. This data helps us improve
product quality, resolve issues faster, and better understand how our products are used.

The collected data is anonymous and does not include personal information. The amount of
transmitted data is minimal and is used only for diagnostic and product improvement
purposes.
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Collected Data

The driver collects the following data:

¢ Product name and version.

e Name of the process (application) using the driver.

e License information: license type, license number, and license status.
e Operating system name and version, number of processor cores.

e An anonymous user identifier.

The user identifier is an internal ID generated only for statistical purposes. It is not the

operating system user name and cannot be used to identify the actual user.
e An anonymous hardware identifier.

The hardware identifier is an internal ID generated only for statistical purposes. It does not

contain any data that can identify specific hardware.

e Database server name and version.

e Names of connection parameters used to connect to the database server.

Only parameter names are collected. We do not collect parameter values such as database

name, user name, or password.
e Connection result: success, or a numeric error code if the connection fails.

Only the numeric error codes are collected. We do not collect full error messages, which

might contain sensitive data (for example, database or user names).

Default Settings

Usage statistics is enabled by default when you install the driver.

To disable usage statistics, follow the instructions for your operating system:

e Enable or Disable Usage Statistics on Windows
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3.7.1 Enable or Disable on Windows

Enable or Disable Usage Statistics on Windows

Usage statistics is enabled by default when you install the driver. You can disable it in one of
the following ways:

¢ During installation: In the installation wizard or from the command line.

¢ After installation: By editing the Windows Registry.

Disable Usage Statistics in the Installation Wizard
To disable usage statistics in the installation wizard, clear the Improvement Program

checkbox on the last page of the wizard. The checkbox is selected by default.

@ Setup - Devart ODBC Driver —

Completing the Devart ODBC Driver Setup
Wizard

Setup has finished installing Devart ODBC Driver on your
computer.

[ Improvement Program™

ODBC Driver

Hedg s improve oo praducts and s Bsoes Taster by sharing a Emiled sef of
anarynious data, nchedng Tunconalily wadge statstes, dagnislic miomation, and
pesTarmance dala.

Disable Usage Statistics From the Command Line

When you install the driver from the command line, you can disable usage statistics by
adding the /NOUSAGESTATISTICS parameter to the command.
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Silent and Very Silent Mode

To disable statistics during silent or very silent installation with the EXE installer, run one of
the following commands:

DevartODBCSlack.exe /NOUSAGESTATISTICS /SILENT
DevartobDBCSlack.exe /NOUSAGESTATISTICS /VERYSILENT

Quiet Mode

To disable statistics during quiet installation with the MSl installer, run the following command
as an administrator:

msiexec /i DevartODBCSlack.msi /g NOUSAGESTATISTICS=true

Change Usage Statistics Settings in the Windows Registry

To enable or disable usage statistics for an installed driver, edit the Windows Registry as
follows:

1. Open the Registry Editor. To do this, press Win+R, type regedit in the Run dialog, and
press Enter.
2. Depending on your driver version, navigate to one of the following keys:

e 64-bit driver: HKEY _LOCAL_MACHINE\SOFTWARE\ODBC\ODBCINST.INI\Devart ODBC Driver for

Slack

e 32-bit driver: HKEY_LOCAL_MACHINE\SOFTWARE \WOW6432Node\ODBC\ODBCINST.INI\Devart ODBC

Driver for Slack

3. Set the value of the usagestatistics parameter to False to disable statistics, or True to

enable statistics.

3.8 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetlInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Slack supports all deprecated functions for backward compatibility.
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The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle v ISO 92 connection,
statement, or

descriptor handle.

Connects to a
specific driver by

SQLConnect ' ISO 92 data source name,
user ID, and

password.

Connects to a
specific driver by
connection string or
_ requests that the
SQLDriverConnect v ODBC _

Driver Manager and
driver display
connection dialog

boxes for the user.
Obtains an

SQLAllocEnv v Deprecated environment handle
allocated from driver.
Obtains a

SQLAllocConnect v Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose
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Returns the list of
SQLDataSources y S0 92 available data
sources, handled by
the Driver Manager
Returns the list of
installed drivers and
SQLDrivers ' ODBC their attributes,
handles by Driver
Manager
Returns information
SQLGetinfo y SO 92 abouta specific
driver and data
source.
Returns the functions
SQLGetFunctions v, ISO 92 supported by the
driver.
Returns information
SQLGetTypelnfo v, ISO 92 about supported

data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes
Function Name Support Standard Purpose

Sets a connection
SQLSetConnectAttr v, ISO 92

attribute.

Returns the value of
SQLGetConnectAttr v, ISO 92 a connection

attribute.
SQLSetConnectOpti v Deprecated Sets a connection
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on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

Deprecated

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

Deprecated

option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e

Standard

Deprecated

ISO 92

ODBC

ISO 92

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later
execution.

Assigns storage for
a parameterinan
SQL statement.

Returns the cursor

name associated
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with a statement

handle.
SQLSetCursorNam Specifies a cursor
v ISO 92
e name.
. Sets options that
SQLSetScrollOption
v OoDBC control cursor
S
behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute ./ ISO 92

statement.

_ Executes a
SQLExecDirect v ISO 92

statement

Returns the text of an
, SQL statement as
SQLNativeSq| ./ ODBC
translated by the
driver.
Returns the
_ description for a
SQLDescribeParam v ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v ISO 92 of parameters ina

statement.

Used in conjunction

with SQLPutData to
SQLParamData v, ISO 92

supply parameter

data at execution
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time. (Useful for long

data values.)

Sends part or all of a

data value for a
SQLPutData v ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
Returns the number

of rows affected by
SQLRowCount v ISO 92

aninsert, update, or

delete request.

Returns the number
SQLNumResultCols v ISO 92 of columns in the

result set.

] Describes a column
SQLDescribeCol v ISO 92
in the result set.

Describes attributes
SQLColAttribute v ISO 92 of a column in the

result set.

Describes attributes
SQLColAttributes v Deprecated of a columnin the

result set.
SOLFetch Py SO 92 Returns multiple

result rows.

Returns scrollable

SQLFetchScroll v ISO 92 "
result rows.
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Returns scrollable
SQLExtendedFetch v Deprecated I
result rows.

Positions a cursor
within a fetched
block of data and
enables an
SQLSetPos v ODBC
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
. bookmark
SQLBulkOperations ./ ODBC
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information
Function Name Support Standard Purpose
Returns additional
SQLError v Deprecated error or status
information
Returns additional
diagnostic
o information (a single
SQLGetDiagField v ISO 92

field of the
diagnostic data

structure).
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SQLGetDiagRec

ISO 92

Returns additional
diagnostic
information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About

Database Objects (Catalog Functions)

Function Name

SQLColumnPrivileg

es

SQLColumns

SQLForeignKeys

SQLPrimaryKeys

SQLProcedureColu

mns

Standard

ODBC

X/Open

ODBC

ODBC

ODBC

Purpose
Returns a list of

columns and
associated
privileges for one or
more tables.
Returns the list of
column names in
specified tables.
Returns a list of
column names that
make up foreign
keys, if they exist for
a specified table.
Returns the list of
column names that
make up the primary

key for a table.

Returns the list of

input and output

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using ODBC Driver 61

SQLProcedures

SQLSpecialColumn

S

SQL Statistics

SQLTablePrivileges

v ODBC

' X/Open

v ISO 92

v ODBC

parameters, as well
as the columns that
constitute the result
set for the specified
procedures.
Returns the list of
procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
that are
automatically
updated when any
value inthe row is
updated by a
transaction.
Returns statistics
about a single table
and the list of
indexes associated
with the table.

Returns a list of
tables and the

privileges
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SQLTables v X/Open

associated with
each table.

Returns the list of
table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard
SQLTransact v Deprecated
SQLENndTran v, ISO 92

Purpose
Commits or rolls

back a transaction
Commits or rolls

back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard
SQLFreeStmt v ISO 92
SQLCloseCursor v, ISO 92
SQLCancel v ISO 92

Purpose
Ends statement

processing, discards
pending results, and,
optionally, frees all
resources
associated with the
statement handle.
Closes a cursor that
has been opened on
a statement handle.
Cancels an SQL

statement.
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ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
. Closes the
SQLDisconnect v ISO 92
connection.
Releases an

environment,
SQLFreeHandle v, ISO 92 connection,

statement, or

descriptor handle.

Releases connection
SQLFreeConnect v Deprecated

handle.

Releases an

SQLFreeEnv ' Deprecated
environment handle.

4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for Slack with ODBC-compliant tools.

e DBeaver

¢ |nformatica PowerCenter

e Microsoft Access

¢ Microsoft Excel

¢ Microsoft Visual Studio

e OpenOffice and LibreOffice

e Oracle Database Link

e PHP
e Power Bl

e Python
e QlikView
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4.1

411

e SQL Server Management Studio

e SSIS

e Tableau

Using in DBeaver

This section describes how to connect DBeaver to Slack using Devart ODBC Driver for
Slack.

e Connect DBeaver Community to Slack through ODBC

e Connect DBeaver Enterprise to Slack through ODBC

Connect DBeaver Community to Slack through ODBC

DBeaver Community and DBeaver Enterprise let users connect to Slack via ODBC, enabling
SQL-based querying, reporting, and data management.

If you need basic ODBC connectivity to Slack and are comfortable with manual configuration
using a generic ODBC Connection, choose DBeaver Community—a free, open-source
database management tool.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise. For more information on
connecting to Slack data from DBeaver Enterprise, see Connect DBeaver Enterprise to Slack
through ODBC.

Initial configuration

1. Download jdbc-odbc-bridge-jre7.jar and x64/3dbcodbc.d11 from Github.

2. Download the Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package

from the Microsoft website.

The built-in legacy ODBC driver was removed in DBeaver Community Edition 23.1. If you're
using an earlier version of DBeaver Community, skip steps 1 and 2.

3. Configure an ODBC data source. For more information, see Windows DSN Configuration.

4. On the Advanced Settings tab of the DSN configuration window, select Ansi from the
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String Types.

This option is required for the proper display of the SQL_WVARCAHAR data type in DBeaver.
It also ensures that all string types will be returned as SQL_CHAR, SQL_VARCHAR, and
SQL_LONGVARCHAR.

Devart ODBC Driver Configuration et

General Advanced Settings Tragng License About

Metadata
B Empty Strings as NULL B allow NULL Strings

[ ] Return Foreign Keys {may significantly degrade performance)

Cache Metadata 1 Day bt
Connection

Connection Timeout &0 [ UTC Dates
Query Timeout &0 [ Indude Deleted

Use Local Regional Settings when converting to string

[] Numbers [ | Dates and Times
Compatibility

ODBC Behavior Default e

String Types Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONt ~

Test Connection - Cancel

Connect to Slack

1. In DBeaver, select Database > Driver Manager.

2. Click New.
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=% Driver Manager

Type part of database/driver name to filter

Mame

W sOlite
1 Altibase
@ Apache Calcite Avatica
& Apache Ignite
# Apache Kylin
> B3 AWS
s S Azure
& Arure Databricks
Q Babelfish via TDS (beta)
[| Cache
= (Cassandra
ClickHouse
ClickHouse (Legacy)
A% Clondhern:

Generic provider

3. Configure the following properties for a new driver:

¢ |n the Driver Name field, enter ODBC.
¢ |In the Class Name field, enter sun.jdbc.odbc.JdbcOdbcDriver

¢ In the URL Template field, select jdbc:odbc:{database}.

Copy

Edit ...
Delete
Un-delete

T - User defined

& - Unavailable

Close
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@ Create new driver

Settings | Libraries | Default properties | Advanced parameters

Driver Name:  ODBC Driver Type: | = Generic v

Class Mame: sun,jdbc.odbe)dbcQdbeDriver

URL Template: jdbciodbo{database}
Default Port:

Default Database:

Default User:

[[JErmbedded [] Propagate driver properties [_] No authentication [_JiAllow Empty Password:
[[] Use legacy JDBC instantiation [ Thread safe driver

Description

1D 55052241-1D12-5734-4177-5C2F49673070

Description:

Reset to Defaults Cancel

4. On the Libraries tab, click Add File.

5. Select the jdbc-odbc-bridge-jre7.jar, then click OK. After that, select 3dbcodbc.d11, then
click OK.
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(@) Create new driver

O X
Settings | Libraries | Default properties | Advanced parameters
s Ci\Users) \Downloads\download_files\jdbc-odbc-bridge-jre? jar hdd File
En C\Usersy \Downloadshdownload_files\JdbcOdbe.dll s
Add Folder
Add Artifact
Edit ...
Delete
Download/Update
Information
Classpath
Driver class: ~ | Find Class Export
Reset to Defaults oK

Cancel
[

6. Once a new ODBC driver appears on the list, click Close.
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=% Driver Manager O >

Type part of database/driver name to filter

Mame # Copy

MDB Cluster

® Neodj Edit ..

M Metezza Delete
MucDB -

c8 OceanBase Un-delete

O Ocient

E ODBC T - User defined

= ODBC - Legacy B - Unavailable

E] Omnisci (formerly MapD)
:.) Open Distro Elasticsearch
8. OpenEdge

h_-"j OpenSearch

E Cracle

MirientE

Close [:?

7. Select Database > New Database Connection.
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(g) DBeaver 24.3.5
File Edit Mavigate Search 50LEditor Database Window Help
¢ - JsaL ~

f® Database Navigator [ Projects

e—1

Mew Database Connection

Mew Connection from JDBC URL

0w

Driver Manager

Enter a part of object name here

Disconnect All

Open Dashboard

% B

Tools
Context tools
& Tasks

8. Select the ODBC driver, then click Next.

= O x
Ctrl+Shift+ M | s
=5
Ctrl+ Alt+5Shift+ B
>
Alt+"
* T|en
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| ) Connect to a database O >

Select your database

Create new database connection. Find your database driver in the list below.

Type part of database/driver name to filter ¥ | Sortby: O Title €@ Score
|
2 Al ¥y d ™ |
Ty crn® ORACLE
& Popular MariaDB MySQl
EN SOL
D2 for LUW MaraDB MySOL Oracle
B NoSQL
EN Analytical
EN Timeseries :‘;_;.‘23 AlTisase
N Embedded ﬁ‘ﬁﬂkﬁ,e
rver
“F Hadoop / BigData ! ~
PostgreS0L SOL Server S0Line Alibaze Apache Calcite
Auatica
-
Test Connection ... < Back Mesxt = Finish Cancel

9. In the Database/Schema field, specify the name of your DSN.
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Generic JDBC Connection Settings
ODBC connection settings

Main | Driver properties | 55H

General
Connect by: © Host (JURL

Jjdbc:odbo:DEEAVER_DATASOURCE
Database/Schema: DBEAVER_DATASOURCE

-+ Metwork configurations...

Authentication (Database Mative)

Username:

Password: B Save password

(1) Connection variables information

Driver name: ODBC

Test Connection ... < Back

Connection details (name, type, ... ]

Driver Settings

m
-

10. Optional: Select Test Connection to verify the connection settings.

E Connection test

Driver: JDBC-ODBC Eridge (DevartODBC
(03.04.0200)

11. Click Finish.

The database appears on the left pane.

=

.dil) 2.0001

Details ==

12. To view the data stored in a table, expand the database structure and click the needed

table.
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(%) DBeaver 24.3.5 - Account = a X
Eile Edit Mavigate Search 50OLEditor Database Window Help
¢ v| W & | [OsaL «:[% Commit [2FRolback T v @ Auto |4 v DBEAVER DATASOURCE ~ [E <N/A> v @y~ b »: Q ~
Q iE|®
f® Database Mavigator 3 [ Projects = O FBAccount X S5 DBEAVER_DATASOURCE B8 Solution = 0
= FF Properties | ) Data ﬁg-n ER Diagram|
Enter a part of object name here T - -
« =, DBEAVER DATASOURCE EEAC(UU”tlzs- nression to filter results (use Ctri+Space » |v e d T = =
~ [ Tables | [z o) . V‘AZV|A-!NHI! V|A-ZV|A-ZV|AZV|AZV|AZV| [ Value X i |
o
’ ;i“e"ti"a’e"me'““’” fH 118 0012400 [1  [MULL] Kate West (Sample) Custorr [MULL Kings P [NULL B R |
? ccoun —"110 | 001240 [1 [MULL] Kate West (Sample) Custor [MNULL 9 Tagor Singape Smgap: 00108000020EKXLA & | &
5 9 AccountChangebvent b1 E AD
s M AccountCleanlnfo — 120 oo2400 [ ] IULL] Kate West (Sample) Custor [MULL 312 Cor Austin TX gg
5 FM AccountContactRole [_3' 121 oo2400 [ ] [MULL] Kate West (Sample) Custorr [MULL 5255, L Burling NC ®
5 [ AccountContactRoleChangeEvent 122 oo2400 [ ] IULL] Kate West (Sample) Custorr [ULL 2 Place Paris IULL i
5 M9 AccountFeed = 123 0012400 [ ] IULL] Kate West (Sample) Custorr [MULL 1301 He Lawren KS N
s B9 AccountHistory 2 124 | 001240 []  [MULL] KateWest (Sample) Custorr [MULL 2334 N. Chicag: IL B
5 B AccountPartner E 125 | 0012400 []  [MULL] Kate West (Sample) Custorr [MULL 620 SW Portlan OR
» B8 AccountShare 126 0012400 [ ] IULL] Kate West (Sample)  Custor [MULL 838 N E Tucson AZ
» B8 ActionLinkGroupTemplate 127 0012400 [ ] [MULL] Kate West (Sample) Custorr [MULL 1307 Av New Yc NY
» A ActionLinkTemnplate 128 oo2400 [ ] IULLT Kate West (Sample) IULL] [MULL. The Lar San Fra CA
> FA ActiveFeaturelicenseMetric 129 | 0011p00 [ ] JULL] Kate West (Sample) [NULL] [NULL) [NULL] [MULL] [NULL
» A ActivePermSetLicenseMetric 120 nninant 11 1 Kate Weet (Samnlel 1 1
3 B3 ActiveProfileMetric int
5 E2 ActivityFieldHistory @ Refresh v | () Save v Cancel = S i@ = il¢ € » U X Exportdata ~ | €8
5 A ActivityHistory - -
200 Z 200+ : () 200 row(s) fetched - 0.653s (0.061s fetch), on 2025-02-19 at 17:20:16 - 5 waming(s) l‘_‘\
S, DBEAVER_DATASOURCE » FF Account Table: Announcement | EET | en
1. Select SQL Editor > New SQL script.
(&) DBeaver 24,35 - Solution - ] X
File Edit Mavigate Search 50L Editor Database Window Help
¥ -‘ Ve q| [Jsc [J OpensaLscript F2
Last edited SOL script Ctrl+Enter
DBEAVER_DATASOURCE ~ [ E ’ Q 124 | @
[ New SOL script Ctrl+]
= =+ =
£= Database Navigator X [ Open 50L console Cirl+Alt+Enter =
. Panels >
Enter a part of object name here ST~ o
L/ - - J
5 B8 Seclution Rayoul 2 |
s+ [ SolutionFeed Context 3 ¥ | Az Solutiont [y x| = x|
5 B9 SeclutionHiste -
FA SelutionStat ] Aut cti ith igat 0000000 B Eg =
¥ clutionStatus uto-sync connection with navigator 2 5012400000 a | =
» E5 Stamp Open separate connection > 00000003 OcvwCzAA| S5
» FH StampAssignment . LL
» B StaticResource - i il I [] @
» B3 StreamingChannel 3 30124000000cvD3AAI [ 00000003 5]
» B3 StreamingChannelShare ] 30124000000cvDAAAI [] 00000006 E
s+ [ TabDefinition ’f—, 7 50124000000cvD5AAI [] 00000007
> E TabledVerify_c E E
» o TabledVerify__ChangeEvent I ] @ Refresh ~ @ () Save = Cancel : =5 Z4 If ==
» 3 TableauHostMapping
r . -
» [ TableauHostMappingShare HE € > M b d, Exportdata ~ g 200 X 0

« A Tack

=% » B2 Solution  Table: TaskPriority

10 row(s) fetched - 0.241s (0.003s fetch), on 2025-02-24 at 16:15:48

|EI-_—I'|en
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2. Enter your query.

() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search 50l Editor Database Window Help
L3 v| ¢ ¢ [Jsa ~i[} = | T ~ @ | Aute |40 v DBEAVERDATASOURCE ~+ [H]<N/A> + 3~ & » Q ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
= & E [ 3 SELECT SolutionName, SolutionNote FROM Solution,‘|
Enter a part of object name here ¥ - ».
> B8 Site o]
> B8 SiteDetail -
» A SiteFeed -
» P SiteHistory
» A SitelframeWWhiteListUrl
> FH SiteRedirectMapping
» E2 Solution
5 A SolutionFeed
» F2 SelutionHistory
» A SolutionStatus
» B8 Stamp
» FH StampAssignment
» A StaticResource e ]
> FH StreamingChannel
» F2 StreamingChannelShare
B
» F2 TabDefinition I
» B8 TabledVerify_c I}
> FX TabledVerify_ ChangeEvent =
3 A TableauHostMapping HE
EET | en | Writable Smart Insert 1.8
3. Select SQL Editor > Execute SQL query.
The query results are displayed in the main window.
() DBeaver 24.3.5 - <DBEAVER DATASOURCE> Script-2 = [m] x
File Edit Mavigate Search SOLEditor Database Window Help
& v| oW [Jsa - t 2 T @ Auto |49 v DBEAVER DATASOURCE ~ [ <N/A> ~ iy~ &b viQ ~
Q B|@®
f® Database Navigator 3 [ Projects = B & DBEAVER_DATASOURCE P Solution [, *<DBEAVER_DATASOURCE> Seript-2 3 = 0
=+ 8 » SELECT SolutionName, SolutionNote FROM Solution;|
Enter a part of object name here ¥ - ».
> B8 Site 3
> B8 SiteDetail m
» A SiteFeed
s 3 SiteHistory T SELECT SolutionMame, Solu | § 5 £nt to filt t t b v | 2T~ - -
» B9 SitelframeWhiteListUrl = | 22 SolutionName w | Az SolutionNote -  Value X = g
SiteRedirectM had 2
z ; Sloleu‘tleo:e wdld, isij GC1020 Portable Generator Switch Mal‘fud If the generator switch is not working, rerr [ U =] =0 “3_’0
. & Generator assembly instructions unclear  The Maintenance Manuals for the GC1020 GC1020 Portable | & | &
5 A SolutionFeed g
s E3 SolutionHistory - 3 Maintenance guidelines for generator unc The Maintenance Manuals for the GC1060 -
» [ SolutionStatus E 4 Selecting the Right Generator for Your Nee GenWatt offers a wide range of electric ge @)
» [ Stamp 5 GC3000 Series Propane Generator Ignition The GC3000 series propane generators nee A
> FE StampAssignment & Starting generator after electrical failure  After an electical failure, the generator has N
> FF StaticResource 7 Electrical wiring installation for GC5060  The red wiring from the top electronic par iz
» F2 StreamingChannel s GenWatt SLA Commitments GenWatt offers four different SLAs with dil =,
» F2 StreamingChannelShare é 9 Electronic panel fitting loose On the GC3020, the electronic panel is knc
» FH TabDefinition | g 10 GenWatt Installation Services GenWatt Corporation has a full-service su|
» F3 TabledVerify_c -
> B8 TabledVerify_ChangeEvent @ Refresh e v SR m =il < oo : 1 Exportdata ~ 3
> FA TableauHostMapping
200 XY o10: 10 row(s) fetched - 0.378<, on 2025-02-19 at 18:34:18 [ Ja}
EET | en | Writable Smart Insert 1.8
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41.2

Connect DBeaver Enterprise to Slack through ODBC

DBeaver Enterprise and DBeaver Community let users connect to Slack via ODBC, enabling
SQL-based querying, reporting, and data management.

If you require a simplified connection setup with built-in ODBC support, enhanced security,
and performance features, you may try DBeaver Enterprise.

If you need basic ODBC connectivity to Slack and are comfortable with manual configuration
using a generic ODBC connection, choose DBeaver Community—a free, open-source
database management tool. For more information on connecting to Slack data from DBeaver
Community, see Connect DBeaver Community to Slack through ODBC.

Connect to Slack

To connect to the Slack database from DBeaver Enterprise:
1. Select Database > New Database Connection.

2. Select the ODBC driver and click Next.
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) Connect to a database O x
Select your database
Create new database connection. Find your database driver in the list below.
Type part of database/driver name to filter & | Sortby: (O Title @ Score
|
£ Al ST §
E P la ‘:::E-F ‘: [y 1\-\: I
i MariaDB MySQL
Em saL )
Db2 for LUW MariaDB MongoDB MySOL
N NoSOL
£ Analytical
0 Timeseries St 4 b ?&Z’
8 Embedded ORACLE op-o oL G
4 h SOL Server
= Oracle Postgres0L Redshift Snowflake SOL Server

Test Connection ... < Back Finish Cancel

3. In the Database Source field, specify the name of your DSN.
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@) Connect to a database O *
ODBC Connection Settings 0 D
ODEC connecticn settings BC
Main | Driver pruperties| 55H| = Metwork configurations...
Connection
Type: @ Data Source () Manual
Data Source: ‘ DEEAVER_DATASOURCE |

(i) Open ODBC Administrator tool

Authentication

Authentication: Database Mative -

Lzername:

Password: B Save password @
(E} Connection variables information Connection details (name, type, ... )
Driver name: ODBC Driver Settings

Test Connection ... < Back MNext = Cancel

4. Optional: Select Test Connection to verify the connection settings.

E Connection test O X

@ Connected (6527 ma)

Serven N

Driverr DBeaver JDBC-ODBC Bridge (DevartODBC" o «.dlf)
1.0.71 (03.04.0200)

Details ==

5. Click Finish.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

78 ODBC Driver for Slack

The database appears on the left pane.

6. To view the data stored in a table, expand the database structure and click the needed

table.

@ DBeaver Enterprise 24.3.0 - Account

£0) ~ ' [J] DBEAVER DATASOURCE ~ [E] < N/A >

File Edit Mavigate S5earch 50l Editor Database Window Help
€| v v Osa - T e A
f® Database Navigator X [ Projects = O B Account X [FB AccountChangeEvent
. P
=+ 3 F2 Properties | £} Data D-Eﬁ ER Diagram
Enter a part of object name here h

[m]

X

o -m-avia-

Q B|@

= 8

Eﬂ DBEAVER_DATASOURCE [ Tables ~ [T Account

L)
« [ DBEAVER_DATASOURCE £R Account |23 B AR
v [ Tables I = @ | Az | Az BillingStreet - ‘ a2 BillingCity + ‘ a2 BillingState . [ value x| = s |
» FH AcceptedEventRelation % : w-B Eﬂ 2 hd
» B Account " =
> E AccountChangeEvent _ 2 312 Constitution PlaceTAustin, TX 78767TUS/ Austin TX UK w
5 M9 AccountCleaninfo é 3 888 N Euclié THallis Center, Room 501 TTucse Tuc.son AT gg
» 2 AccountContactRole T4 2 Place Jussieu Paris ) ()]
5> F AccountContactRoleChangeEvent £ 3 The Landmark @ One Market San Francisco CA =
©
5 F AccountFeed S 6 2334 N, Michigan Avenue, Suite 1300TChicac Chicago IL .
> B8 AccountHistory Y 7 9 Tagore LanellSingapore, Singapore 7874721 Singapore Singapore iz
» A AccountPartner 8 345 Shoreline ParkTMountain View, CA 8404 Mountain View CA =y
» (A AccountShare 9 1301 Avenue of the Americas TMNew York, NY Mew York NY
5 FH ActionLinkGroupTemplate 10 1301 Hoch Drive Lawrence KS
» B2 ActionlinkTemplate 1 525 5. Lexington Ave Burlington NC
» BB ActiveFeaturelicenseMetric 12 620 SW 5th Avenue Suite 400TPortland, Oreg Portland OR
. - . -
> 3 ActivePermSetLicenseMetric s IB Kings Park, 17th Avenue, Team Valley Tradin [
» [ ActiveProfileMetric ‘15
> FH ActivityFieldHistory £ —
> FH ActivityHistory
» F2 AdditionalMumber @ Refresh + ° - Wil < > : 1 Exportdata v 4%
s P Address 5
200 RARER - 13 row(s) fetched - 0.209s (0.057s fetch), on 2025-02-20 at 20:3%:07 '2
EET | en

Query Slack data

1. Select SQL Editor > New SQL script.
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() DBeaver Enterprise 24.3.0 - Solution - O X
File Edit MNavigate Search SOLEditor Database Window Help
¢ ‘ 9 # % | Osc O OpensaLscript ER
- . i
: m DBEAVER DATASOURCE 15 Last edited SQL script Q M | @
T New SQL script Ctrl+]
& Database Navigator = Open 5L console = 0
Enter a part of object name here — B
> [0 SlaProcess Layout > DATASQURCE [ Tables = [T Solution
v E5 Solution Select active schema erresh |[v| BT v dm~ =~
> v Celumns o o ) '
> [ Keys £+ connection Trom navigator v | az Solutionh ¥ | Az Solutionh v | e |
> I Foreign Keys Auto-sync connection with navigater 00000010 GenWatt Install = &
[
>l I:;exes To e 5 00000001 GC1020 Portabl | &
> ferences = s | VIV I LELW Ll 00000002 Generator asser 29
» B SolutionFeed = ®
» FH SelutionHistory - T e
R h = : Save w [®] Cancel : = =3 = —
» BB SolutionStatus | E @ Refres O b Can ISy 24 CH S =
> EB SPSemiAttributes o i< < > Ol M it bpordaa vigk 20 X 10 i
» 8 Stamp 9 -
) 10 row(s) fetched - 0.264s (0.016s fetch), on 2025-02-24 at 16:40:38 =
- I I
2. Enter your query.
(@) DBeaver Enterprise 24,3.0 - <DBEAVER_DATASOURCE> Script = a X

File Edit Mavigate Search 50L Editor Database Window Help
¢ v| % & N | [Tsat =:i[} Commit [ Rollback T~ & Auto o EDBEAVER_DATASOURCE - <NA> v~~~ ~iQ ~
Q i®|l@®

= Database Navigator ¢ [ Projects = B [ Account A AccountChangeEvent Q *<DBEAVER_DATASOURCE> Script ¢ =
§

= & ] SELECT SolutionName, SolutionNote FROM Snlutinn,‘|

1Y) Iy (G sepung === | oupy [T O

Enter a part of object name here N
w DBEAVER_DATASOURCE
v [ Tables I
> FH AcceptedEventRelation
» A Account
» B2 AccountChangeEvent
» 2 AccountCleaninfo
5 A AccountContactRole
» 2 AccountContactRoleChangeEvent
» FA AccountFeed
» FH AccountHistory
» B8 AccountPartner
» B8 AccountShare
> F2 ActionLinkGroupTemplate
» F2 ActionLinkTemplate
» B8 ActiveFeaturelicenseMetric n
» A ActivePermSetLicenseMetric
» A ActiveProfileMetric B
> BB ActivityFieldHistory
> FH ActivityHistory )
5 [ AdditionalMumber [
o= v
5 P Address 0= < . 0‘)

| EI:T| en | Writable | Smart Insert 1:49:48 Sel

M@ lmE >

3. Select SQL Editor > Execute SQL query.

The query results are displayed in the main window.
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@ DBeaver Enterprise 24.3.0 - <DBEAVER_DATASOURCE> Script = a x
Eile Edit Mavigate Search 50LEditor Database Window Help
L3 v| & W | [Jsa ~ T v @i Auto |4D v [FIDBEAVERDATASOURCE ~ El<N/A> v @~ @l v & v Q ~
Q B|@
f® Database Mavig.. » [ Projects = B FH Account 8 AccountChangeEvent [, *<DBEAVER_DATASOURCE= Script % = 8
= & | 3 SELECT SolutionName, SolutionNote FROM Solution; D
Enter a part of object name here T~ =
=
~ [ DBEAVER_DATASOURCE =
v [ Tables | B solution1
> FH AcceptedEventRelation T SELECT SolutionName, Solt | 5 2 P lw| B T v =~
» [ Account ——
5 F9 AccountChangeEvent E = | a7 SelutionName | a7 SelutionNote ¥ | T Value X = g
> 8 AccountCleaninfo M O | GenWatt Corporation has a full-service suppc | U= 0 ":,_?
> 8 AccountContactRole o 2 GC1020 Portable Generator Switch Malfunctior If the generator switch is not working, remowe Geniatt Instal =
> F3 AccountContactRoleChangeEvent 273 Generator assembly instructions unclear The Maintenance Manuals for the GC1020 are =
> B Ac(ountFe.ed [?;' 4 Maintenance guidelines for generator unclear  The Maintenance Manuals for the GC1060 are ®
> B icmuntslstor)r + 5§ Selecting the Right Generator for Your MNeeds  GenWatt offers a wide range of electric gener i
’ g Accounts:rtner é 6 GC3000 Series Propane Generator Ignition The GC3000 series propane generators need t i
? c(.nun. are 27 Starting generator after electrical failure After an electical failure, the generator has to i)
» B3 ActionLinkGroupTemplate . L . ™ + =]
Lo 8 Electrical wiring installation for GC5060 The red wiring from the top electronic panel ¢ =
» FE ActionLinkTemplate = . . ; d
5 FF ActiveFeatureLicenseMetric s 9 Electronic panel fitting loose On the GC3020, the electronic panel is known
5 O ActivePermSetLicenseMetric 3:: 10 GenWatt SLA Commitments GenWatt offers four different SLAs with differ
» B8 ActiveProfileMetric il [—
» FH ActivityFieldHistory @ Ref 3 ] :
resh - : - T R T, Exportdata ~ :
> B Ackhiybitory B . W= > 2  Bxp X
200 x 10 : =10 row(s) fetched - 0.35%s, on 2025-02-20 at 20:46:03 l‘_\
EET | en | Writable Smart Insert 1:45:48 Sel

4.2 Using in DBxtra

Troubleshooting Slack ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Slack in DBxtra.

Due to incompatibilities between DBxtra and Slack, leaving the sqL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 Or ANSI sqQL/2ee3 for DBxtra version 11.0.1 or newer, and to ANST
sqL/2ee3 for versions prior to 11.0.1.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools 81

Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

1

Connection timeout | 15| 5| sqL dislect| | MS Access 2000/... |w |

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel

4.3 Using in Informatica PowerCenter

You can connect Informatica PowerCenter to Slack through an ODBC driver on Windows to
unify and manage data across these systems.

Prerequisites

e Configure the Informatica services.
¢ |nstall the PowerCenter Client tools.

e Create a repository folder in PowerCenter Repository Manager.
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¢ |nstall Devart ODBC Driver for Slack. For instructions, see Installation.

e Configure a data source name (DSN). For instructions, see Windows DSN Configuration.

Add a data source in Informatica PowerCenter

Before you proceed, make sure PowerCenter Designer isn't running.

1.Open-the.c:\Informatica\10.4.1\clients\PowerCenterClient\client\bin\powrmart.ini-file

in a text editor.
2. In the [obBcbLL] section, add s1ack=ExTODBC.DLL, then save the changes.
3. Open PowerCenter Designer.
4. Double-click the repository name (in this example, PCRS), enter your Informatica

credentials, then click Connect.

® Informatica PowerCenter Designer - [Start Page] o O %
0 Repository Edit View Tools Versioning Windows Help = =] 3
9& " | o= 1 | %= 2 E|
0 0 @ @ | [s Peg P @

=l

E Repositories

g [pcrs (‘ Informatica'| PowerCenter 10 ®

Getting Started Resource Center
Mew Features and Enhancements Informatica.com
Product Overview Informatica Network
Connect to Repository *
Connect to Repository
Repositary: PCRS Cancel
Username: | USERNAME ‘ Help
=)
e [seeerenerer ‘ fg Incements
= Mare =3
] _ - Connect E predictive analytics,
Security Domain: Mative = B, and integrated health
domains.

Sign Up now to start using Operational Insights.

Copyright & 1853-2020 Informatica LLC. All Rights Reserved

x|
|

4[4[+ ¥\ Save fFetch Log } Generate }, Validate }, Debugger }, Session Log }, Notffications / < >
Ready 0

5. Double-click the repository folder (in this example, ODBC connections), then select

Sources > Import from Database.
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o Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - ]
5‘9 Repository  Edit View Tools Layout Versioning  Sources  Window Help -

[ ODBC connections - [PCRS] w |- Import from Databa: l‘ =2 %

.= Import frem File...

QOO LB Import from Cobol File...

==l Import XML Definition...
L2l

& Repositories

G- G PR Zoul
e B Import From PeopleSoft ...
[ Business Components
- [ Sources ‘Web Service Provider L4
B Targets Import from Powerbxchange...
2 Cubes Import From Salesforce
) D\meﬂsions. Import From AmazonRSCloudAdapter
~ [ Transformations Import From Amazen53Plugin
B Mapplets i
) Mappings Import from Informatica Cloud...
- [f3 User-Defined Functions Create PowerExchange for BigQuery Source...
Create PowerExchange For Snowflake Source...
Create PowerExchange for Microsoft Dynamics 365 for Sales Source...
Create PowerExchange for Google Cloud Spanner Source...
Create PowerExchange for Google Analytics Source...
Create AzureDWv3 Source...
Create PowerExchange for Google Cloud Storage Source..,
Create PowerExchange For PostgreSQOL Source..,
Create PowerExchange for Kafka Source...
Create MongoDB Source...
Create SAPTableReader Source...
=4 Create...
< ._'51 Compare...
=
|
| ‘ | [\Save AFetch Log )\Generate ,\Valldate }\Debugger l,\Sasslorl Log )\ Matifications / H 4
Import from a given database NUM

The Import Tables dialog opens.

. From the ODBC data source menu, select the needed DSN.

6
7. In the Username and Password fields, enter your Slack credentials.
8. Under Show owners, select All.

]

. Click Connect.

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

84 ODBC Driver for Slack

Import Tables >

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ ...

|Jse Kerberos Authentication Cancel
Username: | USERNAME | Help
Owner name: <ALL=
PaSSI.ﬂ,Iﬂrd: | ------------| |
Select tables

Show owners:

Default

Search for tables named:

I:I Search

Select all

Select naone

10.In the Select tables section, expand the tree and select the tables you want to import.

11.Click OK.
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Import Tables

Connect to Database

ODBC data source: | PRE-COMFIGURED _DSM (Devart ODBC Driver for |~ |...

Cancel
|Jse Kerberos Authentication
Help
Username: | USERNAME | Z
Owrer name: <ALL > ==
Easswurd: | (121221173 7%] | F'.E—t_:ﬂr‘lﬂECt
Select tables
=-0 -iBLES * | Show owners:
----- 1] AcceptedEventRelation
----- Biiil Account — =z
""" EEE AccountContactRelation Search for tables named:
----- I AccountContactRole emch
----- fif] AccountFeed I:I
g1 Accounttistory |
----- gia) AccountPartner
----- if] AccountShare
----- [ ActionLinkGroupTemplate Select al
----- [{f] ActionLinkTemplate W
< 3 Select none

The table schemas appear in the Source Analyzer, and the data source is added to the
Sources subfolder of the repository folder. You can now create mappings and work with

Slack data in Informatica PowerCenter.

85
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Informatica PowerCenter Designer - [Source Analyzer - ODBC connections - [PCRS]] - ] *
] Y
5’:’) Repository Edit  View Tools Layout Versioning Sources Window Help - & x
[ ODBC connections - [PCRS-LIN] ~ | @ .)“15 100% ~ £ @ '5; 'QD ':»éa
QDO | L5
==
. 2y B B g
& Repositories
= 8 pas CMSRO0ES) 1)) :
=] @ ODBC connections K Name Datatype ™
i [ Business Components 9 Id nvarchar
- @ Sources IsDeleted bit
5 [PRE-CONFIGURED DSN MasterFecond - RRSSAODECI I =
B Targets Name K Name Datatype ™
Cubes
g Dimensions e % nvarchar
. - Parentld nvarchar
-~ [ Transformations = - 2 )
ype _JfgstntHstory (ODBC)  [%)
g veppies CreatedByld | K Name Datatype
applng.s X CreatedDate d h
i [f) User-Defined Functions = # L.Liz il
IsDeleted bit
Accountld [ RIRRSRNERO DB L=
CreatedByld K Name Datatype  *
CreatedDate @ d nvarchar
S AccountFromld nvarchar
Account Told nvarchar
COpportunityld nvarchar
Role nvarchar
< >
v
< >
=
=
| | | |\Save AFatch Log ,\Generate ,\Validate P\Debugger ,\Sesswon Log )\Noi'rficaticns f H £ >
Ready MUM
4.4 Using in Microsoft Access

Connecting Microsoft Access to Slack Using an ODBC
Driver

This article explains how to connect Microsoft Access to Slack through the standard ODBC
interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
spreadsheet applications like Excel to organize, store, and retrieve large amounts of related

data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Slack data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. It is
assumed that you have already installed and configured a DSN for ODBC driver for Slack.
For the purpose of this article, we tested an ODBC connection to Slack through our ODBC
drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in Slack.
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Importing Slack Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Slack and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps
checkbox. Click Close.

9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Slack Data in Microsoft Access Through an ODBC

Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.
6. Select the DSN that you have configured for Slack and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click

OK.
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4.5

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Slack table as the unique record identifier. You are linking
multiple tables, you will be prompted to select unique record identifiers for each of the
selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Using in Microsoft Excel

Connecting to Slack from Microsoft Excel using ODBC
Driver for Slack

You can use Microsoft Excel to access data from a Slack database using ODBC connector.
With ODBC Driver, you can import the data directly into an Excel Spreadsheet and present it

as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if you have
installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Slack with Get & Transform (Power Query)

e Connecting Excel to Slack with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Slack with the Query Wizard

e Connecting Excel to Slack with Microsoft Query

e Connecting Excel to Slack with PowerPivot

Connecting Excel to Slack with Get & Transform (Power
Query)

You can use Get & Transform (Power Query) to connect to Slack from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Slack.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.
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Bookl - Excel Evgeniy Lemeshov [ O
Insert Page Layout Formulas Review View Help & Tellme X Share
& [o |_ B  a [TA ~N [ Be B 5
]
B, g2 o Y:&. " B B =
B i - .
Get Refresh z| Sort Filter Text to G What-If Forecast Outline
Data ~ D All = Y cColumns =8 7 Ex Analysis =~  Sheet M
G Sort & Filter Data Tools Forecast ~
j From File L
c v
[y
From Database L - - - - t ' ' =
— 4 »
R Y 0 - | + 100%
= am From Azure » From Table/Range
-]
_';jj From Online Services * _@ From Web
m —
.¢. From Other Sources * | & From Microsoft Query
[= 4
' - 3
S Combine Queries _.¢. From QDBEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the
connection string for your data source (without credentials, which are defined in the
credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.
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From ODBC

Data source name (DSN)

Devart ODBC Dniver b

4 Advanced options

Connection string (non-credential properties) (optional) &

501 statement [optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (opticnal)

(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.

ODBC driver
Default or Custom @ dsn=Devart ODBC Driver
. Use a username and password to access a data source with an QDBC driver,

Windows

User name
Database myusemame

Password

FEERRBERDEE

Credential connection string properties (optional) (O

Back Cancel

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools

91

If your database is not password-protected or you've already specified your credentials in the

ODBC data source settings, select Default or Custom and press Connect

Default or Custom

Windows

Database

< dsn=Devart O

Don't specify any credentials or only connection string properties.

Credential connection string properties (optional) (D)

Back

QDBC driver

DBC Driver

Connect

Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

Navigator

Select multiple items
Display Options ~
4 ODBC (dsn=Slack) [32]

[ AuthTeams
DirectChannels
DirectChannelsHistory
DirectChannelsReplies
DoMotDisturbSettings
Emojis
FileComments
Files
GroupChannelMembers
GroupCharnnels
GroupChannelsHistory
GroupChannelsPurposes
GroupChannelsReplies
GroupChannelsTopics
MultipartyDirectChannels
MultipartyDirectChannelsHistary
MultipartyDirectChannelsReplies
Pins_DirectChannels
Pins_GroupChannels
Pins_MultipartyDirectChannels
Pins_PublicChannels

PublicChannels

o

Users

Id
U03BVIESCCT
UO3CKBLSPRN
UD3NQBULZMS
USLACKBOT

Teamld

TO3BXS387HA
TO3BXS3STHA
TO3BXS38THA
TO3BXS39THA

Name
devart_ssis_data_flow
waorkdeves
devart_odbc_driver

slackbot

Color
FALSE 4bbele
FALSE 9fo%e7
FALSE e7392d
FALSE 757575

Load

RealName

Devart SIS Data Flow
Waork Dev

Devart ODBC Driver
Slackbot

Transform Data

TimeZ
Amerii
Europ:
Ameris

Ameris

Cancel

© 2025 Devart  Request Support ODBC Forum Provide Feedback



https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

92 ODBC Driver for Slack

The data from the table will be a displayed in an Excel spreadsheet where you can further

work with it.
File Home Insert Page Layout Formulas Data Review View Help Table Design Query
Table Name: Summarize with PivotTable F‘ @ D ~ Header Row First Column ~| Filter Button
, =y = LO
U.sers EJ Remove Duplicates nsert | Export Refresh '?' Total Row Last Column
‘B Resize Table (E% Convert to Range Slicer - - g\j + Banded Rows Banded Columns
Properties Tools External Table Data Table Style Options
Al & F
A B C D E F -
Mid BElteamid n Mame ﬂ Deleted HCoIor n RealName ﬂ
2 |USLACKBOT TO3ZBXS397HA slackbot FALSE 757575 Slackbot
3 |U03BVI69CCT TO3BXS397HA devart_ssis_data_flow FALSE  4bbele Devart S5IS Data Flow
4 |UO3CKSLSPRN TO3BXS397HA workdev3d FALSE 9f69e7 Work Dev
5 |UDSNQBULZMS TO3BXS397HA devart_odbc_driver FALSE e7352d Devart ODBC Driver
6 —
T —
8 —
g —
10 |
11 |
12|
13 |
14 |
15 |

Connecting Excel to Slack with Data Connection Wizard
(Legacy Wizard)
You can use this option to connect to OLE DB or ODBC external data source that has

already been defined.
1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

2. In the opened dialog, select ODBC DSN and click Next to continue.

3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter
and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.
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6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Slack with the Query Wizard

You can use this option to create a simple query for retrieving data from Slack to Excel via
ODBC driver.

1. Open Excel, in the main menu, click the Data tab.
2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.
3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to Slack with Microsoft Query

You can use this option to create a more complex query for retrieving Slack data to Excel via
ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Slack). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click
the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.
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4.6

Connecting Excel to Slack with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Slack), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).

7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

Using in Microsoft Visual Studio

Importing Slack Data into Visual Studio Through an
ODBC Connection

A Visual Studio is a powerful tool containing features that allow editing, debugging, and
compilating the code and creating applications that can be connected to any databases
product and services on a local machine and network, and any type of cloud (private, public,
or hybrid). To connect Visual Studio to a data source such as Slack, you can use an
appropriate ODBC driver.

This guide describes how to connect to Slack and retrieve data importing them to Visual
Studio with an ODBC driver. It is assumed that you have already installed and configured a
DSN for ODBC driver for Slack.

1. Run Visual Studio Desktop and click Tool and select Connect to Database.
2. In the Add connection dialog box, select the Microsoft ODBC Data Source as a data
source.

3. In the Data source specification point expand the Data Source Name (DSN) drop-down
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list and select the previously configured DSN for Slack. Alternatively, you can connect to
the database by entering the DSN in a Use connection string field. To check whether

your connection is successful, click Test connection. Click OK.

4. If your data source is password-protected, Visual Studio will prompt you for user

credentials. Type your Username and Password in the respective fields and click OK.

5. In the Server Explorer you can see the database structure. Choose Tables, right-click the
table you want to view the data of and select Retrieve Data. You can also preview the

contents of the database objects by clicking on them.

4.7 Using in OpenOffice and LibreOffice

Connecting to Slack from OpenOffice and LibreOffice
using ODBC Driver for Slack

The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Slack data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Slack, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.
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Apache P
€3 OpenOffice™ 4

; ; = .
‘E Text Document; E Drawing

@ Spreadsheet @ Database
Presentation E Formula
@ Open... bt |_r/_| Templates...

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Slack, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Slack and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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Mew Database.odb - OpenOffice Base - O W

b

File Edit View [nsert TJools Window Help

E-
S -

2 _ [E Create Table in Design View... Description
[ﬂ Use Wizard to Create Table...
Tables

2 - NN EO L |

ﬁ

F
Que
Carriers f Mone =
Customers
1E Fulfillments
F

) QOrderltems

m Orders
Packages

Rep Products

ries
orms Marketplaces
orts

9 Marketplaces - New Databasel7 - OpenOffice Base: Table Data View
File Edit View |nsert Tools Window Help

=1 e tun R vy

Id | Mame | CanRefresh | SupportsCustomMappings | SupportsCustomStatuses
B [115  fcumatica [+] ] [+
|40 Alibaba G O O
I F Amazon [] [] ]
113 Amazon AU G| G| O
|32 Amazonca [+] [+] ]
~ |42 Amazon DE [+] ] ]
" |43 AmazonEs [+] ] ]
~ |44 AmazonFR [+] ] ]
" |45 AmazonIT [+] ] ]
a7 Amazon MX [+] [+] ]
|15 Amazon UK [] [] ]
|58 AmeriCommerce [] ] ]
~ |3282 back-market ] O] O
~ 109 Bandcamp [+] ] =]
~ 131 BestBuycCA =1 O O

7. To create an SQL query, click Queries in the Database pane, then click Create Queryin

SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

'R-E-0 naE-efe@ne |
- [ create Query in Design View... Description
15 5 Use wizard to Create Query... Create a query entering an SQL statement dirs
Tables |§‘|‘.|,|. Create Query in 5QL View... |

e

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

e Mew Database.odb : Queryl - OpenOffice Base: Query Design
File Edit View |nsert Tools Window Help

E@ %@ W .Eﬁ.

G BE- P NBIR v r

Id | Mame | CanRefresh | SupportsCustomMappings SupportsCustom5Statuses
B Scurmatica [+] ] [+
~ 140 Alibaba G| O O
F Amazon [+] [+] ]
"~ |13 Amazon AU G| ] O
" |32 Amazon CA [+] [+] ]
" |42 Amazon DE [+] ] ]
" |43 AmazonES [+] ] ]
" |44 AmazonFR [+] ] ]
~ |45 AmazonIT [+] ] ]
" |37 Amazon MX [+] [+] ]
|15 Amazon UK [+] [+] ]
" |58 AmeriCommerce [+] ] [+
3282 back-market = O O

Recaord |1 of 40"

id
Ed
0]

SELECT * FROM Marketplaces
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4.8 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.

Configure the Initialization File

After installing the gateway and the ODBC driver for Slack, create an initialization file for your

Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initslack.ora. You need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_FDps_conNNeEcT_INFO parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=STlack

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orRACLE_HOME\NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
) (ADDRESS = (PROTOCOL = TCP) (HOST = localhost) (PORT = 1521))
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Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_naAME) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=
(SID_NAME=STack)

(ORACLE_HOME=D: \ORACLE_HOME)
(PROGRAM=dg4odbc)

)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the

listener.ora file.

Slack =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
(siD = slack)

)
(HS = 0K)
)
Create Database Links
To access an ODBC data source, you must create a database link using a database tool like
SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the
CREATE DATABASE LINK statement, as follows:
CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also
Configuring Oracle Database Gateway for ODBC
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49 Using in PHP

Connecting to Slack from PHP using ODBC Driver for
Slack

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Slack via ODBC. The script connects to Slack

database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$obpBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Slack} ;AP
Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($ODBCConnection, $SQLQuery);

Step 3: Print the result set
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The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

$result = odbc_result_all($Recordset, "border=1");
odbc_close($0DBCConnection);

7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.

Using in Power Bl

Importing Slack Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Slack, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Slack and import data into Power Bl Desktop using an

ODBC driver. It is assumed that you have already installed and configured a DSN for ODBC

driver for Slack.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Slack

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user

credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
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of the database objects by clicking on them.

7. To load the Slack data into Power Bl for analysis, select the needed table and click Load.

411 Using in Python

Installing the ODBC Driver for Slack

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Slack. To use the ODBC driver as a

translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Slack from Python using ODBC Driver for
Slack

Here’s an example to show you how to connect to Slack via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Slack};API Key=myapike

Step 2: Insert a row
Here's a simple example of how to execute an insert statement to test the connection to the

database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query
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The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.
cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
print (row)
row = cursor.fetchone()

cursor.close()
cnxn.close()

Using in QlikView

Connecting to Slack from QlikView using ODBC Driver
for Slack

This tutorial describes how to connect and configure QlikView to retrieve data from Slack for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Slack, perform the
steps below:
1. Open the QlikView client application and click File > New. Close the Getting Started

wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{| File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help
{0 New Ctri+N || & | #a| v | [ | @) |5? B ¢ K Clear ~| @ Back &) Forward | & Lock &' Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites »
= save Ctrl+5
Save As... F12
Mail as Attachment...
Mail with Bookmark as a Link
| P . +P
Print Sheet...
Source Control »
Export »
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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V]
File Edit Insert Tab Tools Help
-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main v |23 =

[GET

@ Connect to Data Source s

User ID Pazswond

|m_l,.lid | | sesee| |

Canecel

Data Sources

Help

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
- - - Devart ODBLC Driver for bMagento
Dats  Functions Variables  Settings Dievart ODBC Ciriver for MaiChimp
. Diewart ODBC Diriver for MySEIL
Database Diata from Files | | Devart ODBC Driver far MetSuite
. Dewart ODBC Driver for Oracle

| el ~ Connect... L] Relative Faths Dievart ODBC Diriver for SOL Azure
[JUseFTP Dievart ODBC Driver for SGLite
[ Fores 32 Eit Select... Meseart ONAC Mriver bor o sce

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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@ Edit Script [QV2]
 File Edit Insert Tab Tools Help

1Reload #Debug | < 4 4 Tabs Main
Main
ODBC COMMECT to Slack;
SELECT * FROM Users;|
Data Functions  Variables  Setlings
Database
ODBC - Conmecl...
(] Force 32 Ba Select .

Sheet Properties [Main]

General Fields Objects Security Triggers

Available Fields

Color

Daleted
Has2FA

Id

IsAdrmin
IsApplser
IsBot

IsCrwner
IsPrimary Owner
IsRestricted

- O *
Dafa from Files

[ Relative Faths Table Files...
|| Use FTF ok Fle.

Web Files .

Field Data...

OK Cancel Help
*

Add >

Add All ==

< Remove

Fields Displayed in Listboxes

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

choose a different database from the database drop-down list. Select the necessary tables

and fields. You can retrieve date from multiple tables and fields by selecting them and

clicking Add. When you are ready with your SELECT statement, click OK. You will get
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back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

= Create Select Statement — O b4
Dala source Slack Connect,.,
Database Drbver..
Charvar Suppor..
Dalabase Tables Flelds Texd Order .
[ ] Show all Fins_DireciChaninels e
Pins_GroupChannels Color
B Tables Fina_MultipartyDireciChannels Deleted I
Fins_PublicChannels Has2FA
B views PublicChannels id
PublicChannelsHistory Iz Admin
[] synonyms PublicChannelsPurposes IsAppLiser
FublicChannelsReples IsBol
B System Tables  PublicChannels Topics IsCwner
Reminders IsPrimary Crwner
[ Aliases Starg Is Restricted
Teaminfo e Dk ad
TeamintegrationlLogs | Bhow lcon for Key Fields

Script Tabde  Columns  Preview  Blobs

SQL SELECT * © Column
FROM Users; ) Row
() Struetured
[ ] Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.
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413

= ClikView x84 Personal Edition - [C:\Users\alinak\Downloads'sla.quw®]

| File Edit View Selections Layout|Settings Bookmarks Re

|_,__,-..J i @4 e o3l T Add Sheet..
Main Promote Sheet
Name F Demote Sheet
devart_odbc_driver J Remave Sheet
devart_ssis_data_flow 57 @ Select Fields...
j::db::gg Mew Sheet Object List Box...
873924 % Rearrange Sheet Objects Statistics Box...
£ Adjust Off-Screen Objects Multi Box...
Align/Distribute Table Box...
Chart...
Input Box...
Current Selections Box...
Button...
Text Object...
Line/Arrow Object...
Slider/Calendar Object...
Bookmark Object...
Search Object..
Container...

Tools Object Window Help

| hClear - 2Back #Fonward_sLock Unlock |

Custom Object...

System Table

= QlikView x64 Personal Edition - [Ch\Users\alinak\Downloads\sla.quvw®]
| File Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

| i cal 2 g0 ol gls Jg._:?l

1 Clear- #Back #Fonvard & Lock + Unlock |

Main
Color TimeZoneOffset Name Id

757575 -25200 slackbat USLACKBOT
dbbele -25200 devart_ssis_data_flow UO03BVI&SCCT
o9f&0e? 10800 workdev9 UO3CKBLSPRN
e7392d -25200 devart_odbc_driver  UOSNQBULZMS

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Slack from SQL

Server Management Studio using ODBC Driver for Slack.

e Creating a Linked Server

© 2025 Devart  Request Support ODBC Forum Provide Feedback


https://www.devart.com/company/contactform.html?category=0&product=odbc/activecampaign
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/activecampaign/feedback.html

Using in Third-Party Tools| 117

4131

e Troubleshooting in SSMS

Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN.

¢ The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for Slack and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Slack from SQL Server Management
Studio using ODBC Driver for Slack

You can use the Microsoft SQL Server Management Studio to connect your Slack data to an
SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Slack and
merge them with your SQL Server database. You can create a linked server with one of these
methods: by using the options in the Object Explorer or by executing stored procedures.

Below are major advantages of using SQL Server Linked Servers to connect to Slack:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the
organization.

3. The ability to work with diverse data sources in the same way.
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How to configure a SQL Server Linked Server to connect
to Slack

You can follow the steps to create a linked server for Slack in SQL Server Management
Studio by using Object Explorer:
1. Start your Management Studio and choose your SQL Server instance.

2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers
and then click on New Linked Server.
3. Configure your linked server in the dialog box:
e Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for
Slack. Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Slack databases through SQL Server.

Retrieving Data From Slack

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer
Connect~ ¥ *¥ (R

= i@ ALINAK\SQLEXPRESS (SOL Server 15.0.2080 - DATA

Databases
Security
= Server Objects
Backup Devices
= Linked Servers
= Providers
@t ADsDSOObject
@t Microsoft ACE.OLEDB.12.0
@t Microsoft ACE.OLEDE.16.0
@t MSDAQSP
wE MSDASCOL
wE MSOLAP
Wt MSOLEDBSCL

In the appeared Provider Options window, enable the Allow inprocess checkbox:

®H Provider Options - Microsoft OLE DB Provider for ODBC Drivers

Selecta page IT Script ~ &) Help
& General

Provider options:

Enable Name

Limlemd mmmamen samimn dhin messi

Create a new Linked Server

Dynamic parameter
MNested queries
Level zero only
Allow inprocess

Maon transacted updates
Index as access path
Digallow adhoc access
Supports "Like’ operator
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
Selecta page HSGI‘iDt"ﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. SLACK. In the Product Name and Data
Source fields you need to indicate the System DSN that you've previously created - more info
on System DSN setup can be found here.
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e
Selecta page IT Seript ~ ) Help
& General
& Security
& Server Options Linked server:
Servertype:
i) SQL Server
© Cther data source
Provider:
Product name:
Data source:
Provider string:
Location
Catalog
Connection
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Microgsoft OLE DB Provider for ODBC Drivers

Devart ODBC Driver for Zoho Projects

Zoho Projects

The Slack tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:

File Edit View Project
i@-o|@B-u-2

SOL Complete

Tools  Windoy

W | B New Query B & &

| Execute

Object Explorer

Connect = T KT ﬁ e

v 1 x

= @ EVGEMIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT

Databases

Security

= Server Objects
Backup Devices
2
Providers

B ORACLE

H POSTGRESQL

B saute

B EEH

Enter your SQL query in the editor window and click Execute to run the query:
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Lx,; S50LCuery1.sql - NBALINAK\SQLEXPRESS.master (DATASOFTVAlinak (33))" - Microsoft SQL Server Management Studio (Administrator)
File  Edit View Project Debug Tools Window  Help

e' |ﬁ3' -2 |J"|J:§'|Neruery Emnnnxﬁ.nul |:'|—‘| | - '|@|

- | | Execute Debug | | | | | _

AR Bl SOl Queryl.sql - NB...ASOFT\Alinak (33))* & X

select * from [SLACK]...[Users]

Object Explorer

Connect~ ¥ ¥ (R
= @ MBALINAK\SOLEXPRESS (SOL Server 9.0.3042 - DATASOFTVAI
Databases
Security
=] Server Objects
Backup Devices
= Linked Servers
Providers

100 % -
B Resutts B Messages

Id Teamld Mame Deleted  Color
1 | TO3BXSISTHA  slackbot 0 757575
2 UD3BVJESCCT  TOIBXSIGTHA  devart_ssis_data flow 0 4bbe2s
Catalogs 3 UDICKBLSPRN  TO3BXS3ISTHA  workdevdd 0 o697
System Catalogs 4 UO3NQBUL2ZMS  TO3BXS357HA  devart_odbe_driver 0 e7392d
= i default
= Tables

Systemn Tables
A AuthTeams
A DirectChannels
B DirectChannelsHistory

As a result, you can see the contents of the selected table retrieved directly from the Slack
account you are connected to.

See also
¢ Troubleshooting SSMS

4.13.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

properties:
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-
. Compenent Services

Console Root
a 0 Component Services
4[] Computers
a & My Computer
» [o] COM+ Applicatio
[ -] DCOM Config
& [2] Running Processe
[ fj] Distributed Trans:
[ E Event Viewer (Local)
3 Q.,, Services (Local)

Windo.., Windows... Windows R.. Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo.,..  Windows.. WMIPro.. WMIProvi.

s & & &

Micresoft.... Microsoft.L... MicrosoftV... Microsoft....

ApplD
MMC (ALY MSMDPP - MsRdpSess...
Applicati.. LIZE

¥ & & &

MSTTS MahimicSe... MAP Agent Map Elevated
DecObj Cla.. Service COM class
NCLUA NDFAPI netman netprofm

¥ & & @&

NetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions »

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

.
| Permissions for (2206CDB0-10C1-11D1-89E0-00COAF... ()

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

oK ]| Cancel Apply

After this you should be able to edit MSDAINITIALIZE security settings.

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:

"Cannot create an instance of OLE DB provider"

414 Usingin SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Slack as a

translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
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an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data
Connection
—
-
Compatibility
ODBC Behavior [ Ver 2.x o
String Types Default &

IUse Local Regional Settings when converting to string

[ Imumbers [ ]Dates and times

Test Connection - Cancel

415 Usingin Tableau

Importing Slack Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Slack from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.
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128 ODBC Driver for Slack

1. Run Tableau Desktop.
. On the start page, select More... in the Connect pane.

. Choose Other Databases (ODBC).

A WN

. Expand the DSN drop-down list and select the DSN that you have created and configured
for Slack. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for Slack from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Slack.

. You should see the list of all tables you have access to in the connected data source.

© 0 N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the
table.

10.Hit Update Now to retrieve and display the data.
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